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Chapter 1: About the Printer
Driver

The Card Printer Driver uses Microsoft XPS print technology to
support printing from currently available applications. This chapter
provides a task overview of what the Card Printer Driver does, and
a description of the communication between the Card Printer
Driver and the card printer.

Supported Operating Systems

The following operating systems are supported by the Card Printer Driver:
= Windows XP

= Windows 7

= Windows 8

= Windows Server 2003

= Windows Server 2008

« Windows Server 2012

For more information on PC and operating system requirements, refer to the
printer’s Installation and Administrator’s Guide.

Because the Card Printer Driver supports multiple Windows operating systems,
the procedures in this Guide assume you can navigate to the appropriate
Windows panels for your system. The Guide describes how to set up and use the
Card Printer Driver from the appropriate window (for example, Printer
Properties). Operating system-specific exceptions are noted, where necessary.

Driver Task Overview

Refer to “Install the Driver” on page 8 for the steps to follow to install the
printer and driver.

Once installed, the Card Printer Driver:
1. Receives card data from an application.
2. Processes it for personalizing a card.

3. Optionally, encrypts data transactions with the printer for secure printing.

XPS Card Printer Driver Guide



4. Sends the prepared data to the printer.
5. Checks the printer for card completion.

6. Displays any conditions (messages) associated with the card job.

Printer/Driver Communication

The printer communicates with the PC via the Card Printer Driver using either a
USB cable or an Ethernet cable. For both connection types, the printer treats
communication as if the PC is connected over a network. If you have multiple
printers, each printer has a separate instance of the Card Printer Driver.

= You can update printer settings using the Printer Manager web service. Refer
to the printer’s Installation and Administrator’s Guide for more information
on using the Printer Manager.

< You can customize applications to communicate with the printer through the
Card Printer Driver. If you use a customized application, follow the
instructions in your application.

e Secure printing is available on current models of SD, CD, and CE series
printers. Print jobs are secured with data protection automatically when the
printer is configured to communicate securely. For more information, refer to
“Use the Card Printer Driver for Secure Printing” on page 24.

Printer/Driver Communications Over a Network

The Card Printer Driver requires the current printer IP address when it is
connected to the printer over a network. Refer to the printer’s User’s Guide for
information on how to retrieve the printer’s IP address.

When both printer and PC use an organization's network, the network affects the
speed of data transmission, and can affect who can use the printer. The network
printer can have many PCs connected to it, and each PC can be connected to
multiple printers over the network.

2 About the Printer Driver



Printer/Driver Communications Using a USB Connection

Connecting the printer and a PC using a USB cable automatically creates a local
network. Each time another printer is connected to the PC, it creates a new local
network for the new printer.

You can connect up to eight printers to a PC using USB cables.

o The printer requires a USB 2.0 connection.

XPS Card Printer Driver Guide 3
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Chapter 2: XPS Card Printer
Driver Installation

This chapter provides information about installing
the Card Printer Driver.

Before You Install

The Card Printer Driver typically is installed using the installation CD shipped with
the printer. You also can install it using a downloaded installation file.

Be aware of the following before installing the Card Printer Driver.
« Load the printer ribbon and cards before installing the Card Printer Driver.

= The Card Printer Driver installation assigns a default printer name. Each
printer must have a different name. The installation automatically creates a
unique name.

If your site plans to implement printer sharing, have a printer naming plan in
place before installing the Card Printer Driver. You cannot rename a printer
after sharing is enabled. Refer to “Use Printer Sharing” on page 26 for more
information.

Installation Overview

Basic installation includes the following steps:

1. Select Your Installation Method on page 6

2. Install the Card Printer Driver using one of the following:
< Install Using the Driver Installation CD on page 7

< Install Without the Driver Installation CD on page 8

XPS Card Printer Driver Guide 5



3. Install the driver based on the printer/PC communication method you are
using, either USB or a network connection. Refer to “Install the Driver” on
page 8.

4. Update your existing driver installation if your driver version is 4.0 or newer.
Refer to “Update the Card Printer Driver” on page 15.

Advanced printer setup consists of:

e Connect More Than One Printer on page 22

e Use the Card Printer Driver for Secure Printing on page 24
e Use Printer Sharing on page 26

« Use Printer Pooling on page 31

Select Your Installation Method

Your installation method depends on how many users print to the card printer,
the operating system you use to send card data, and other decisions specific to
your environment.

Choose from the following installation methods:

Use Driver The printer ships with a CD in the printer carton. In most cases,
Installation you install the Card Printer Driver from the CD. Refer to “Install
CD Using the Driver Installation CD” on page 7.

Download If you do not have access to the installation CD, download the
the Driver Card Printer Driver installation file from the website. Refer to

“Install Without the Driver Installation CD” on page 8.

Use a USB Refer to “Install the Driver” on page 8.

Connection

Use a Refer to “Install the Driver” on page 8.

Network

Connection

Update an If Card Printer Driver version 4.0 or newer is installed on your PC,

Existing you can update the Driver to version 4.1 without uninstalling the

Driver previous version. Refer to “Update the Card Printer Driver” on
page 15.

Use Secure Refer to “Use the Card Printer Driver for Secure Printing” on

Printing page 24.

6 XPS Card Printer Driver Installation



Connect to Refer to “Connect More Than One Printer” on page 22.

More Than

One Printer

Use Printer Printer sharing allows one or more PCs (clients) to print cards to

Sharing a printer installed on a different PC (host). Refer to “Use Printer
Sharing” on page 26.

Use Printer A printer pool is a group of printers that act as one printer. Print

Pooling jobs are sent to the pool and are distributed among the
available printers.
Refer to “Use Printer Pooling” on page 31 and “Set Up a
Printer Pool” on page 34.

Install the Card Printer Driver

This section provides information about installing the Card Printer Driver on a PC
running a supported Windows operating system. Refer to “Supported Operating
Systems” on page 1 and the printer's Installation and Administrator's Guide for

complete information on installation requirements.

To begin the Card Printer Driver installation, use the Driver Installation CD, or use
a downloaded installation file if the CD is not available.

Then, install the printer based on the printer/PC communication method you are
using, either a USB or a network connection. Refer to “Install the Driver” on
page 8.

Install Using the Driver Installation CD

The printer ships with the Card Printer Driver Installation CD in the printer carton.
In most cases, install the Card Printer Driver from the Installation CD.

1. Logon tothe PC as a user with administrator access.
2. Insert the Driver Installation CD in the PC’s drive.
3. If the Autoplay dialog box displays, click Run autorun.exe.

4. When the driver installer Welcome page displays, continue with the driver
installation. Refer to “Install the Driver” on page 8.

XPS Card Printer Driver Guide 7



Install Without the Driver Installation CD

Your network might prevent the download or installation of the Card Printer
Driver installation file. Ask your network support personnel for help when
downloading this file and when installing the Card Printer Driver.

If you do not have access to the Card Printer Driver Installation CD, do the
following:

1. Logon tothe PC as a user with administrator access.

2. Obtain the driver download file on a portable storage medium and save it to
your hard drive. If necessary, download the driver file from the website:

http://www.datacard.com

A. Browse to the Downloads area of the website (or the Products page for
the printer) and select the driver for your printer.

B. When the File Download dialog displays, click Save As.
C. Choose a location on your PC, such as C:\Temp, and click Save.
3. Browse to the location of the file saved in Step 2 on your PC.

4. Double-click the downloaded file. The file has a name similar to
XPSCardPrinter_"version".exe. The Welcome page displays.

5. Continue with Install the Driver.
Install the Driver

The following instructions describe how to install the driver using either a USB or
a network connection. Most of the installation procedure is the same for either
method; differences are noted where necessary.

': Caution: If you are installing the driver with a USB connection, do not
connect the USB cable to the printer until instructed. If you start this
procedure with the USB cable connected, problems can result.

8 XPS Card Printer Driver Installation



1. Plugin and power on the printer. Make sure that the cards and ribbon are
loaded correctly. The LCD panel displays READY when the printer is completely
powered on.

2. On the driver installer Welcome page, click Install a Network Printer or Install
a USB Printer.

Install a Metwork Printer

Install a USE Printer

Datacard’
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3. The Card Printer Driver installer displays the license agreement:

EMC-UEER LICENSE AGREEMERNT FOR DATACARD CORPORATION S0F TWAHE L FIRMWAHE ﬂ

IMPORTANT-READ CAREFULLY: This End-User License Agreement CELILA™) = a legally-binding
contract betwean you (he licensee, aither 3& an individual or 3 conporale entity) and Dhatalard
Corporation (the Licenson, refened o as Tatacnd™) for e softwane Bold aceompanies his ELLA,
associgled media, documenlaBon and any frmware (Colleclively, lhe "Solwae™), For puiposes of
this ELILA e term Datacard shall inclede where applicable e Boensars of Datacard, whio shall be
third pary beneficianes hereof. IF YOU DO NOT AGREE TO THE TERME AND COMDITIONG
CONTAINED IN THIS ELILAYOL WUET COMPLETELY REMOVE THE SOFTWARE FROM THE
COMPUTER SYSTEM OR WHICH IT WAS INSTALLED AND PROMPTLY RETURM IT AMDALL
COPIES TO DRTACARD. An amendmeni or addendum io this ELILA may accompany he Software
BY INSTALLIMG, QUFYING OR USING THIZ SOF TWARE YOU UNDERSTAND AHD AGREE TO BE
BOLIMNDG BY THE TERME OF THIS EULA This ELILA=hall also e Subied b the leems and |

Print ELILA

Datacard’

A. Read the license agreement and select Accept.

B. Click the blue arrow on the right to continue.

o If you are installing multiple copies of the driver, you only have to accept the
license agreement once.

The Card Printer Driver begins loading.

Preparing Computer

Irsdiallinry recpeinsd solhasene...

Accept EULA ¢

Prepare Computer -

Install Diriver

Print Sample Card

11101001010

o < If you are using a USB connection, continue with step 4.

= If you are using a network connection, skip to step 5.

XPS Card Printer Driver Installation



4. When prompted, connect the printer to the PC with a USB cable, as shown on
your screen.

Datacard XPS Card Printer

Watching for Printer...

> Plug in the USB data cable.

Accept EULA ./

Prepare Computer 4/

Install Driver <

Print Sample Card

The Card Printer Driver searches for the printer and connects the PC and
printer, displaying the Installing USB Driver page.

Datacard XPS Card Printer

Installing USB Driver...
> This will take about a minute.
Accept EULA
Prepare Computer o/
@ W o

Install Driver ‘

T,

Print Sample Card N\
%

Continue with step 9.

XPS Card Printer Driver Guide 11
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5. Connect the printer to the network with an Ethernet cable.

6. Use the printer LCD screen menu system to retrieve the printer’s IP address.
Refer to your printer’s User’s Guide for details on obtaining the IP address.

7. Enter the IP address.

A. Exit the menu system on the printer.

Make sure that READY displays and the UseR button on the front panel glows
green.

The Installing Network Driver window displays on your PC.

Installing Network Driver

P Installing, please wait...
-

Accept EULA ./
Prepare Computer o/

Install Driver <

Print Sample Card

Enter the printer IP address.

XPS Card Printer Driver Installation



B. When the installer displays the Printer Properties Ports tab, click Configure

Port and type the IP address in the Printer Name or IP Address field on

the Port Settings window.

Fiinles ame ot B Lvhes

Peatacsl
= B I~ PR

I S
Pt fienkier

| LA S

e i Cord R =)

|

[ .m XPE Corl Printer

Bt 1o e folinwaing portie), Doscummnty vwill piisst to tha first free
chicked part.

Pnnter

Descoption
O Frmi= Port
I con:
] Corag:
I COomME:  Serial Port
Lo Serial Fore
1 ALE Pyl 1o P

(e 0T Suandant TOPYT Pae AP Caee] Prestes -

Purt

Serul Part

Seridl Fart

In some cases, the Port Number changes when you enter the printer’s IP address.

The printer uses Port 9100. If a number other than 9100 displays in the Port

Number field, delete the number and enter 9100.

8. Click OK on the Port Settings window to save your settings and close the
window. Then, click Close on the Ports tab to close the Printer Properties

window.

Continue with step 9.

XPS Card Printer Driver Guide
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9. If you have ID software installed on your computer, the Install the Plug-In
screen displays as part of the Card Printer Driver installation. Click Yes and
follow the installation instructions to install the XPS Card Printer plug-in.

Datacard XP5 Card Printer Installatio

The plug-in allows you to use your ID
Software's advanced card-design features
(such as magnetic stripe and smart card) to
I interface with this printer,

(lgl The plug-in can be installed at a
= later time from the driver support
files page of this installer.

Datacard

Install the plug-in for your ID software?

Would you like to install or update
the XPS Card Printer plug-in for
your ID software?

When the Card Printer Driver and any plug-in software are installed, the
Installation Complete page displays.

Accept EULA @
Prapare Computer @
Install Driver

Print Sample Card -«

Installation Complete

Frinter.  ¥PE Card Primter

Op=
|

o ] ] et

e Print 3ample Card

10. Test your printer by printing a sample card. Make sure that READY displays on
the LCD screen, and click Print Sample Card.

For complete information on how to print a sample card or a printer test card,
refer to the printer’s User’s Guide.

XPS Card Printer Driver Installation



11. If necessary, you can install additional support files. Click the
second icon (upper left) on the Welcome page, and select the
items you want to install (such as legacy support files for
enhanced backward compatibility). Refer to “Install Support
Files” on page 20 for more information.

Update the Card Printer Driver

If you currently use the Card Printer Driver version 4.0 or newer, you can update
to Driver version 4.1 without having to remove all installed printers and reinstall
the new driver. Use the Card Printer Driver update process to install the new
version. The updated Card Printer Driver retains your printing preferences and
selections from the previous version.

To find the Card Printer Driver version installed on your PC, open the XPS Card
Printer Properties window and click the About tab.

o If the Card Printer Driver version installed on your PC is older than 4.0, you must
uninstall the current driver and install the new driver.

Before starting the update, be aware of the following:
= The Update the Driver button does not display if any of the following are true:
< You are installing the Card Printer Driver for the first time.

e The installed Card Printer Driver is older than version 4.0, or is the same
version or newer than the driver you are updating.

< You uninstalled the current Card Printer Driver.
« Ashared printer client Card Printer Driver is installed on the PC.

« |f you want to remove the current Card Printer Driver from
your PC, click the Remove the Driver icon and follow the
instructions. The installer Welcome page then displays with the
Install buttons enabled.

< If you are updating the Card Printer Driver on the host system with shared
clients, you can update the shared printer host. Refer to “Update a Shared
Printer” on page 18 for information on updating the client systems.

« You can update a printer pool.

XPS Card Printer Driver Guide 15
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The Card Printer Driver update requires that you restart your computer. Plan to
perform the update at a time that does not interfere with your production schedule.

1. Logon to the PC where the Card Printer Driver is installed.

2. Insert the Driver Installation CD or double-click the downloaded installation

file.

The Card Printer Driver Installer Welcome page displays.

Install a Metwork Printer

natall a USE Printer

Update the Driver

Datacard’

Welcome to the XP3S Card Printer Installer

3. Click Update the Driver. The Update the Driver page displays.

.-

" The update requires a
system reslar

Update the Driver

Updale Now

Updale. 403040 >> 4.1.326.0

4. Click Update Now to start the update process.

XPS Card Printer Driver Installation



5. The Update Complete page displays. Click Restart Now to restart your
computer and complete the update.

Update the Driver

* The update requires a Updale Now
system restart

B Restart to complate update.

Restart Now

If the update fails to complete, the Update Failed dialog box displays. Click
Remove Driver to remove the driver from your PC. You then can install the
driver as a new install (refer to “Install the Driver” on page 8),

Driver Update Failed

""-.\ The driver could not be updated

" Chek Remove Drver and follow the prompls to remose
e current dinver. Then mstall e new wersion

Remowve Driver

XPS Card Printer Driver Guide
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Update a Shared Printer

If you use printer sharing, the host PC and all client PCs must be at the same
version of the Card Printer Driver to work properly. Depending on the operating
system installed on the host and client PCs, one of the following can occur:

The Card Printer Driver on the client PC is updated automatically after you
restart the host after it is updated.

The Card Printer Driver on the client PC must be updated manually. If the
driver on the client PC requires a manual update, the text “Needs new driver”
displays when you select the printer on the Devices and Printers window on the
client PC. (Windows XP users: Open Windows Print Manager and check the
Status column to see messages.)

Update a Client PC Manually

To update the Card Printer Driver on a client system that requires a manual
update, do the following.

18

You might need to restart the client PC before proceeding with the following steps. If
the Update Driver option displays when you select the printer, you do not need to
restart the PC.

Open the Devices and Printers window on the client PC.

Select the printer. The text “Needs new driver” displays next to the printer
name and Update Driver displays on the menu bar.

Select Update Driver.
On the Do you trust this printer dialog box, click Install Driver.
The updated Card Printer Driver is installed on the client PC.

Press F5 to refresh the Devices and Printers window to clear the “Needs new
driver” message.

XPS Card Printer Driver Installation



Verify the Client Update

After the client PC has been updated with the new Card Printer Driver version,
verify that the update completed properly and that your settings and preferences
were not changed.

1.

Open the Devices and Printers window on the client PC and right-click the
printer.

Select either Printer properties or Printing preferences and select the About
tab.

Verify that the driver version is correct.

Check your printer properties settings and printing preferences and verify that
they are correct.

Print sample cards to confirm that cards print successfully.

XPS Card Printer Driver Guide 19



Install Support Files

1. Insert the Card Printer Driver Installation CD and follow the prompts. The Card
Printer Installation window displays.

o You can use the Driver Installation CD or the file downloaded from the website.

2. Select the Install driver support items icon at the top of the

installation window (see right). @

The support items window displays.

Select the items to install

Y inglall any of ol Suppor! eplons
and aad-ons

Magnatic stripe fonts

Prirter Plug-in

7 Legacy Suppon

Install Now

Datacard’

3. Select each of the support options you want to install and click Install now.
You can select from the following options

< Windows XP driver support—For shared printers at Windows XP client
PCs only. You must install the Windows XP driver support files on the
client PC.

= Magnetic stripe fonts—Select this option if the shared printer client PC is
processing magnetic stripe cards using magnetic stripe fonts.

20 XPS Card Printer Driver Installation



4.

« Printer Plug-in—Install the XPS Card Printer plug-in for your ID software, if
necessary. A wizard displays and guides you through the plug-in
installation.

= Legacy Support—Select this option if you have an application that uses
fonts or files from older generation desktop printers. Install the Legacy
Support files if you plan to use custom user-defined bitmaps for topcoat
application as it installs the required bitmap files. Refer to “Use a User-
Defined Topcoat Bitmap” on page 70 for more information.

After you install the needed support files, close the Card Printer Installation
window.

Install User Documentation

Install the card printer documentation files from the separate documentation CD.
The document set consists of:

Quick Install Guide

XPS Card Printer Driver Guide

User’s Guide

Installation and Administrator’s Guide
OpenCard Data Format Guide

Software Development Kit (SDK) Programmer’s Reference Guide

XPS Card Printer Driver Guide 21



Advanced Setup

Advanced setup options help you set up your installation to fit your operation’s
needs. Advanced setup includes the following:

Connect More Than One Printer
Use the Card Printer Driver for Secure Printing on page 24
Use Printer Sharing on page 26

Use Printer Pooling on page 31

Connect More Than One Printer

There are several options for connecting more than one printer to a PC. You can
connect to several printers installed on an Ethernet network, or connect multiple
printers to a PC with USB cables.

Use the following guidelines to install more than one printer with USB cables:

e Connect and install one printer at a time. The PC cannot run more than one
installation program at a time.

« You can connect up to eight printers to a PC with USB cables.

= |f you need to connect two card printers to a PC with one USB port, use an
independently powered, high-speed USB hub (USB 2.0) to which both printers
can connect. Do not daisy-chain multiple hubs. (Self-powered hubs are
recommended.)

= Each printer must remain powered on and in the READY state during
installation.

Install Additional USB Printers

For each USB printer installed after the initial USB installation, do the following:

1. Load supplies and power on the printer before starting the installation. Refer
to the printer’s User’s Guide for the steps to load cards and ribbon.

2. Logon to the PC as a user with administrator access.

3. Connect the READY printer to the PC with a USB cable.

22 XPS Card Printer Driver Installation



4. The operating system detects the new device and begins installation.
Depending on your system’s current setup, what you see during the
installation process varies.

e A pop-up window may display during installation.

If the operating system does not display a pop-up window within a few
minutes, check all cables and connections to the printer, and then look at
the PC’s Printers window to determine whether the icon for the new
printer displays. The software sometimes installs without displaying the
pop-up window.

« The operating system usually uses the existing Card Printer Driver files to
install the driver for this printer. Insert the Driver Installation CD only if
you are prompted for it.

Print to More Than One Printer From One PC

When you print to more than one printer from one PC, keep the following in
mind:

= Keep track of the printer names. When messages display, the title bar of the
message box displays the name of the printer that issued the message.

« Select the printer to use from within the card production application.
Card jobs are sent to the selected printer even if more than one card printer is
attached to the PC.

e Each printer has its own icon in the Printers window, and each printer has
separate Properties and Printing Preferences windows. Settings are not shared
among printers.

= Do not mix non-secure and secure printers on PCs that require secure
printing.

XPS Card Printer Driver Guide 23



Use the Card Printer Driver for Secure Printing

Secure printing encrypts print commands and card data and transmits the
information securely from the PC to the printer.

When the Card Printer Driver detects that the printer is enabled for secure
communications, it encrypts the data before sending it to the printer.

Secure Printing Overview

24

Communication with the printer can use one of three protocols. These protocols
are named for the printer command language protocols used to send card print
data between the Card Printer Driver and the printer.

Protocol Secure/Non-Secure
DPCL (first-generation) Non-Secure

DPCL2 (second-generation) Non-Secure

DPCL2 Secure Secure

The Card Printer Driver automatically uses the most secure protocol the printer is
configured to support. The protocol used by the printer displays on the Printer
Properties>Printer Status tab. The Card Printer Driver also reports the protocol
information to applications via the driver SDK.

Non-secure printing is activated automatically for printers that do not have
secure printing capability or are not configured to use secure printing. Non-
secure printing does not encrypt the data sent to the printer.

The Card Printer Driver uses DPCL2Secure as the printer’s secure
communications protocol. Printers are shipped with secure printing enabled. You
can disable (or enable) DPCL2Secure communication through the Printer
Manager web service. Refer to the printer’s Installation and Administrator’s
Guide for complete information on using Printer Manager.

o Printers that provide only DPCL or DPCL2 non-secure printing may be part of

your network. Be sure to identify which printers provide secure printing and
which provide non-secure printing. Do not install or share non-secure printers on
PCs where secure printing is required.
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Set Up Secure Printing

Do the following to set up secure printing:

1. Install a printer that supports secure printing. Refer to the printer’s
Installation and Administrator’s Guide for a list of hardware and software
requirements.

2. Install and set up the Card Printer Driver. Refer to “Install the Driver” on
page 8.

3. If necessary, use the Printer Manager web service to enable secure printing.
Sign on as a WebAdmin and select Printer Setting >Behavior. Select Enabled
for the DPCL2Secure option. Refer to the printer’s Installation and
Administrator’s Guide for complete information on using Printer Manager.

4. Restart the printer and computer for the setting to take effect.
5. Connect your secure printers to the host and client PCs.

After secure printing is set up, the Card Printer Driver automatically detects
and uses secure printing during card production.
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Use Printer Sharing

You can share a printer over a network using Microsoft File and Printer Sharing.

Shared printing includes a host PC and up to 10 client PCs. The printer is
connected to a host PC that has the Card Printer Driver installed. Client PCs then
print to the shared printer over a network. Client PCs do not have the same level
of access to the Card Printer Driver as the host PC.

Printer Sharing Requirements

Before sharing a printer over a network, make sure that the following
requirements are met:

= Each PC that uses the printer must be connected to the same network,
workgroup, or domain.

o Windows XP does not support sharing between computers on a domain.

= The host and the client PC must be using the same type of processor, either
32- or 64-bit.

 The host PC must be configured and enabled for sharing.

e The host PC must remain on at all times with the Windows operating system
running.

« The host PC must grant permissions for users that print to the shared printer.

= When multiple user accounts are configured on a shared printer client, we
recommend that users log on and off when switching from one account to
another. Using the Windows “Switch User” feature keeps multiple user
accounts logged on and may cause issues when viewing messages from the
printer.

= [f you need to rename a printer, do it before you enable printer sharing.

Renaming shared printers is not supported. Do not change printer names after
sharing is enabled. If you rename a shared printer, print requests may fail and
reinstallation may be necessary.
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Supported Operating Systems

The Card Printer Driver supports the following host and client operating system
combinations. See the appropriate appendix for printer sharing setup
information for your host and client systems.

Host Client Refer to

64-bit: 64-bit: Appendix A: Windows 7 and
Windows 7 Windows 7 Windows 8 Printer Sharing
Windows 8 Windows 8

Windows XP, 32-bit | Windows XP, 32-bit | Appendix B: Windows XP Printer

Sharing

Windows Server 32-bit: Appendix C: Windows Server 2003
2003, 32-bit windows XP Printer Sharing

Windows 7

Windows 8
64-bit: 64-bit: Appendix D: Windows Server 2008
Windows Server Windows 7 and 2012 Printer Sharing
2008 windows 8
Windows Server
2012
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Tips for Host PC and Client PC Users
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The user at the host PC has more control over the printer. The host PC typically is
located near the printer and is used by administrator-level users. This section
describes some tasks performed at the host PC.

Understanding these tips for setting up and managing shared printers can help
you install and change your printer setup for your operation’s unique needs.

Feature Printer Sharing Tips
Host PC Users:

Manage Use the Windows Print Manager to manage print jobs.

print queue

Secure To ensure secure printing, make sure that:

printing = The printer you install and share is a secure printer.

= Secure printing is enabled in Printer Manager.

Refer to “Use the Card Printer Driver for Secure
Printing” on page 24.

Security Set up a Windows group account with the users who

permissions for
shared printers

have the same printer security permissions.

For more information, refer to:

“Set Up Group Accounts for Using Shared Printers” on
page 31.

View message
boxes

To set up accounts to view message boxes.

= Enable printer sharing on the Windows Printer
Properties Sharing tab.

= Set up applicable user accounts on the Windows
Printer Properties Security tab. Select the Print and
the Manage this printer permissions for each user or
group. Selecting both of these settings lets individual
users or groups print and view Message boxes from
their PCs, except as noted below.

Windows XP or Windows Server 2003 host: Client PCs
cannot view message boxes. These client PCs must open
the Windows Print Manager. Users of these client PCs may
need to resolve printer errors at the printer.
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Feature

Printer Sharing Tips

View printer status,
supplies, and card
counts

For more information, refer to the following topics:
= Printer Status Tab on page 44
e Card Counts Tab on page 48
= Supplies Tab on page 49

(Windows XP: Users can view this information only at the
host PC. This information is not available from a client PC.)

Client PC Users:

Client

Card Design
Printing
Preferences

Client PC users have different options for high-resolution
printing.
= Client PC users don’t have the Always use best
possible resolution setting.
= Client PC Users must choose the supported resolution
under Custom.

Refer to “Configure PC Printing Preferences for
Sharing” on page 30.

Allow printing and
viewing of
message boxes

Client PC users may be able to view printer messages.
The buttons on message boxes let users resolve some
issues without going to the printer.

Refer to the “Configure Security” section in the appendix
for your operating system.

All PC Users:

Clear error
messages on the
printer or host PC

If you clear the error at the printer’s LCD screen, the error
message on the PC closes automatically and removes
the error message from the Windows Print Manager.

Print to shared
printers in
interactive mode

Host and client PCs cannot use shared printers in
interactive mode.

This restriction prevents using operations such as
magnetic stripe read or smart card personalization.

Update job status
in the Windows
Print Manager

If the Windows Print Manager is already open, press F5 to
update the current print job status in the window.
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Feature

Printer Sharing Tips

Use device
naming rules for

Don’t rename a shared printer. Doing so means all
connected printers may need to be reinstalled at the

shared printers host and client PCs.

Note: Renaming printers after implementing printer
sharing is not supported.

Submit jobs using Shared printers are not supported for jobs submitted using

the driver SDK the driver Software Development Kit (SDK). For more

information on using the SDK, refer to the printer's
Windows Driver Software Development Kit Programmer’s
Reference Guide.

Configure PC Printing Preferences for Sharing
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When you use printer sharing, settings on the client PC must be configured to
match the settings of the host PC. Print quality from the client PC may be affected
if the Windows printing preferences are not the same on the host PC and the
client PC.

Use the Printing Preferences window to set up your printing preferences. Refer to
“Design Tasks in Windows Printing Preferences” on page 59 for complete
information on how to set up printing preferences.

Keep the following in mind when using printer sharing:

When you set up the host PC, write down the settings you specify in the
Printing Preferences window. You use these settings when you set each client
PC’s printing preferences.

The host PC automatically detects and selects the ribbon type. The client PC
does not automatically detect the type of ribbon installed in the printer.
Instead, it defaults to YMCKT ribbon and 300 x 300 dpi resolution. If you select
to use a Split Ribbon option on the host PC, select the same option on the
client PC. Refer to “Print Cards Using Split-Ribbon Color Printing” on page
66.

Select the same topcoat and print blocking options for the front side and back
side print areas. Refer to “Print Area Tab” on page 69.

Set the print resolution on the client PC using the same setting you selected
for the host PC print resolution. Refer to “Print Mode Tab” on page 77.
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Set Up Group Accounts for Using Shared Printers

If you want to define which users can both print cards and view message boxes,
we recommend that you create a group account. Assign the client user accounts
allowed to use the printer to the group account. Then, using the shared printer’s
Printer Properties Security tab, select the Print and Manage this printer
permissions to allow the group to print and display Message boxes.

For more information, refer to the Microsoft documentation on setting up group
accounts and printer security permissions, and the following instructions for your
configuration:

e Appendix A: Windows 7 and Windows 8 Printer Sharing
« Appendix B: Windows XP Printer Sharing
« Appendix C: Windows Server 2003 Printer Sharing

e Appendix D: Windows Server 2008 and 2012 Printer Sharing
Use Windows Print Manager

The Windows :
Print Manageris | soe poes e

onetool available | S b ey e s e
for managing
print jobs across
your host and
client systems. Do not confuse the Windows Print Manager (shown) with the

printer’s Printer Manager web service.

Frip e

— — — —

|
|}
=

If the Windows Print Manager is already open, press F5 to update the current
print job status in the Print Manager window.

Use Printer Pooling

Printer pooling is used in card production environments in which an application
prints to a group of printers. The user chooses to print to the pool and the pool
distributes the print jobs to the next available printer.

e Printer Pooling Requirements on page 32
e QOperating Systems Supported for Printer Pooling on page 33
« Tips for Printer Pooling on page 33

e Set Up a Printer Pool on page 34
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Printer Pooling Requirements

Printer pooling requires that you set up all printers in a pool with the same basic
setup except as noted below. The setup includes connecting printers using an
Ethernet cable only, using the same ribbons, and setting up for non-interactive

32

printing.

All printers in a printer pool
must have the same:

With:

Model number

Examples:
A pool includes:

Only SD260L models
OR Only SD360 models
OR Only SD800 models

The same printing features installed, as
outlined in this table.

Note Do not place non-secure printers in
pools where secure printing is needed. For
more information about secure printing,
refer to “Use the Card Printer Driver for
Secure Printing” on page 24.

Supplies

The same settings applied. For information
on defining printer ribbon settings,
resolution, and other print settings, refer to
“Design Tasks in Windows Printing
Preferences” on page 59.

Network cable type—Ethernet
only

No USB-connected printers. Printer pooling
is not supported for USB-connected
printers.

Non-interactive printing
requirements

No direct, printer-to-PC processing is
permitted. Interactive print processing
requires a connection to a printer, which is
not possible when using a pooled printer.

Note Smart card and magnetic stripe
read commands cannot be processed on
printers in a pool.

Printer Manager settings and
magnetic stripe values

Refer to the printer's Installation and
Administrator's Guide for more
information.

For instructions to set up printer pooling, refer to “Set Up a Printer Pool” on

page 34.
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Operating Systems Supported for Printer Pooling

Printer pooling is supported on all Card Printer Driver-supported operating
systems. For more information on supported operating systems, refer to the
printer's Installation and Administrator's Guide.

Tips for Printer Pooling

Feature Tip for Printer Pooling

Error messages Messages display the name of the main
printer named during the Card Printer Driver
installation, rather than the name of the
specific printer in error.

= To locate the printer with the error
condition, look at each printer in the pool
for warning indicators or LCD messages.

= Card jobs are held at the printer with the
error condition. All subsequent card jobs
print to other printers in the pool. The
printer with the error is not used by the
pool until the error condition is corrected.

= After correcting the error at the printer,

resume or cancel the print job using the
error message on the PC.

Printer Pooling Printer status, card count, and supplies
information information typically shown in the Windows
Printer Properties window is not available to
printers belonging to a printer pool.

For these printers, the Printer Status tab
displays the status as “Printer pooling,” which
indicates that the printer belongs to a printer
pool.

Use Printer Manager to view card counts,
supply information, and the status of individual
printers in the pool. Refer to the printer’s
Installation and Administrator's Guide for
information about using Printer Manager.

Shared Printers Shared printers can be part of a printer pool.
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Feature Tip for Printer Pooling

Print Sample Card and The Print Sample Card and Magstripe Test
Magstripe Test Card not Card buttons on the Printer Properties window
available Status tab are not available for a printer

belonging to a printer pool. Print sample cards
or test cards from the LCD panel on the
printer.

Printer pool print queues A printer that cannot process jobs continues
to have jobs assigned to it by the pool
controller. The Card Printer Driver does not
determine if each printer in the pool is ready
to receive card jobs.

Remove printers that are not available from
the pool until they are functioning and ready
to receive print jobs:

1. Toremove a printer from the pool, open
the Printer Properties window and click
the Ports tab.

2. Remove the check from the port
assigned to the printer.

Some software, such as Microsoft Office (for
example, Word, Excel, Access), sends
multiple-card (batch) files as a single print job.
In this case, the pool sends all cards in the
batch to the same printer. Software designed
specifically for card production sends each
card in the batch as a single print job. The
printer pool distributes single print jobs among
the available printers.

Set Up a Printer Pool

The following instructions describe how to set up printer pooling for all
supported Windows operating systems. Operating system-specific differences
are noted, where necessary. The screens shown may differ slightly from those on
your system

1. Install the first network printer on the host PC. Refer to “Install the Driver”
on page 8.

2. Connect each additional printer you want to include in the pool to the
network using an Ethernet cable.
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3. Write down the IP address of each printer. Refer to your printer’s User’s Guide
for details on obtaining the IP address.

4. Configure the network printers for printer pooling.
A. Display the Devices and Printers window for your operating system.

B. Right-click the card printer icon and select Printer properties to display
the Printer Properties window.

Windows Server 2008 and Windows Server 2012: Select the printer and
click Print server properties on the menu bar.

C. Select the Ports tab.

Windows Server 2008 and Windows Server 2012: On the Print Server
Properties Ports tab, scroll down and highlight the printer to add to the
pool. Click Change Port Settings.

D. Click Add Port.
The Printer Ports window displays (see below).

E. Select Standard TCP/IP Port,

and click New Port. The Add ki A

Available port types:
Adeobe PDF Port Monitor

Standard TCP/IP Printer Port

Wizard page d|Sp|ays_ CutePDF Writer Monitor

Local Port

Standard TCP/IP Port

F. Follow the instructions in
the wizard to add the port.

Click Next to display each W Cancel |

step in the wizard.

G. In the Printer Name or IP
Address field, enter the
name or IP address of the
printer you are adding.

For mhich devios da os want 50 sdd B pad

P

Enter the Printer Wamre o IF address, and 2 port name for the deswed devoe

Printar Nams o [P Addees 172363193

H. In the Port Name field, i prr——
enter a name, such as
Pooled Printer 2.

[.  Click Next.

If the Additional Port
Information Required page
displays, select Custom and click Next.

J.  When the last page of the wizard displays, click Finish.
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Repeat these steps for each printer you want to add to the pool.

Close the Printer Ports window.

been added.

. Click Apply on the Ports tab, if necessary, after all printers and ports have

Windows Server 2008 and Windows Server 2012: Close the Print Server

Properties window.

5. Enable printer pooling.

A

F.

On the Devices and
Printers window, right-
click the printer icon and

select Printer properties.

Select the Ports tab. The
list of printer ports
displays.

Select the Port check box
for the printer that you
want to represent the
pool. (This is the printer

that users select when printing to the pool.)

Select Enable printer pooling.

Select the Port check box next to each port you added and want to be part

of the printer pool.

Click Apply to save the settings.

6. Click OK to close the Printer Properties window.
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Chapter 3: Card Printer Driver
Management Tasks

Card Printer Driver managements tasks are accessed through the
Printer Properties window.

This chapter provides information about the Card Printer Driver, including:
e Use the Printer Properties Window

e Uninstall the Card Printer Driver on page 51

Use the Printer Properties Window

The Printer Properties window allows you to specify the settings and values that
Windows uses to communicate with and manage the printer.

To open the Printer Properties window, display the Printers window on your
system. Right-click the icon for the card printer and select Printer properties. Use
the Printer Properties tabs to define your printer to the PC.
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General Tab

The General tab displays when you first open the Printer Properties window. It
contains basic information about the printer. Click the Preferences button to
display the Printing Preferences window. Refer to “Design Tasks in Windows

Printing Preferences” on page 59 for complete information on using the Printing
Preferences window.

al
= WS Cand Frter Propertied b

Gerernl | Sham | Pots | Aedvarsond | Color Maragernt, | Secuty | Pinter ot | Comt Courts | Supmben | Aot

- KPS Caed Prinfer
L atacr
Comment:
Madel XP% Cod Prinier
Featunes
Colon Yes Paper available

Double-sided Ve 150 I0-1 35 50 « 5388 mim)
Staple Mo
Spetd: Unksrgramn

Mlmamasm resolution: 600 dp

Freferences Brinit Tesit Fage

OK e

The Print Test Page button prints a Windows test page to check PC communication
with the printer. We recommend that you do not use this option. Print a driver
sample card from the “Printer Status Tab” on page 44 instead.

Sharing Tab

Use the Sharing tab to set up printer sharing using a host PC and up to ten client
PCs. Refer to “Use Printer Sharing” on page 26 and the appropriate appendix
for your operating system for complete information on setting up printer sharing.
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Ports Tab

Use the Ports tab to define the IP address of your printer to the PC. Refer to
“Install the Driver” on page 8 and “Set Up a Printer Pool” on page 34 for
information on defining a port during installation or when setting up a printer
pool.

o The Ports tab of the Printer Properties window includes the Enable Bidirectional
Support check box. The Card Printer Driver always uses bidirectional communication
with the printer. Make sure that this option is selected, otherwise all printing from
the Card Printer Driver is disabled.

View Network Information

When the printer and PC using the Card Printer Driver are connected using a
network, the network settings on the PC and the printer must match.

Use the Ports tab on the Card Printer Driver Printer Properties window to enter the
printer’s IP address. Refer to the Port Type section of “Printer Status Tab” on
page 44 to view the setting.

If the printer is set to use DHCP (Dynamic Host Configuration Protocol), the IP
address of the printer can change when the printer is powered off and powered
back on. If this occurs, the Card Printer Driver issues error message 500.

If the printer IP address changes often, use static IP addressing to provide a more
reliable connection. Work with your network support group to identify the IP
address, subnet mask, and gateway address (if used). Then, refer to the printer’s
Installation and Administrator’s Guide for information on setting a static IP
address.

Change a Network IP Address

If you are connecting your PC to a new network printer or if the printer IP address
has changed, you need to change the IP address that is defined in the Printer
Properties Ports tab.

Follow the procedure to change the port settings based on the operating system
you are using:

e Windows XP, Windows 7, Windows 8, and Windows Server 2003 on page
40

e Windows Server 2008 and Windows Server 2012 on page 41

XPS Card Printer Driver Guide 39



Windows XP, Windows 7, Windows 8, and Windows Server 2003

1. Open the Printer
Properties window and
select the Ports tab.

W | Gacarnd | S| Foe | Advseucad | Color Mansgamant | Sacurty | Puctar Simun | Card Courtn | Suppbon | Meoue |

A P Cand Printe

2. Select the installed
network printer you

Prink tc the folipwing post(s]. Biecuments will print to the fir free
thecied port.

Port Deseriplion Frnter
want to change and |IPT5  Frntes Fon
click Configure Port. Bleoe Swiibon s

| COMRE:  Sénial Part
Ul const:  Senal Pert
| FILE: Frnt 14 Fie

- Standard TCP/F Post XPS Card Frinter

Ak Pex. [ meeeren | [ gorigeepon.
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3. On the Configure
Standard TCP/IP Port Monitor
dialog, enter the new IP address
for the printer.

DNFOL Metwork Part

Printer Mame or [P Addnes l?J‘.IEJ.!Iﬂ

4. Click OK to save the new settings Protocel
) & Rarva LF&
and then click Close on the
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Windows Server 2008 and Windows Server 2012

1. Open the Devices and Printers TP
window and click the network 78 - Haome + Bt P .

& L i .
printer you want to change. Addgicn e i Sos oty piing | B el g | =
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2. Click Print server properties

and select the Ports tab on the Print EREEET T

Server Properties window.
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5. On the Configure Standard TCP/IP Port

_ Configure Standard TCP/W Part Monitor =T
Monitor dialog, enter the new IP P—
address for the printer. — Ty
) A Pristee Mame ¢ @ febdreis [vresesad
6. Click OK to save the settings, and N :
then click Close on the Print Server " e
Properties window. et e
LPE, Sattingn

P St Drabled

Advanced Tab

The Advanced tab contains additional printer settings. We recommend you keep
the defaults set when you install the Card Printer Driver.
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o The Card Printer Driver does not support the following options on the Advanced tab:

= The New Driver button. Use the Card Printer Driver update process to update
the driver from Version 4.0 to Version 4.1. Refer to “Update the Card Printer
Driver” on page 15 for complete information.

e The Windows 7 and Windows 8 Keep printed documents option.
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Color Management Tab

Refer to the Printing Preferences window “Color Adjustment Tab” on page 74
and the “Color Printing” section of your printer’s Installation and Administrator’s
Guide for more information.

Security Tab

Use the Security tab to set printer permissions. If the PC to which the printer is
attached has more than one user, set permissions that:

Give users access to all features of the printer and Card Printer Driver,
including messages.

Display messages to inform users when they need to change the ribbon, load
cards, or fix problems.

Prevent access to the printer by unauthorized users.

Log in to the PC as the Creator/Owner (Windows 7, Windows 8) or with
Administrator permissions (Windows XP).

On the Printer Properties window, select the Security tab.

A. Review the Group or User Names list. If the names for which you want to
specify permissions do not appear in the list, add the names.

B. Click Add to open the Users and Groups dialog box.

C. Select a name and click Add. Repeat for each name you want to add.
When you are done adding names, click OK to close the Users and Groups
dialog box.

In the Names list, select the name for which you want to specify permissions.
From the Permissions list, select the access for each user or group:

< To enable printing, select Allow for Print, Manage Printer, and Manage
Documents.

= To prevent a user from printing to the card printer, select Deny for all
permissions.

Click Apply to save the changes.

Repeat steps 3 through 5 to grant access to the printer for other users or
groups.

Click OK to close the Printer Properties window.
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Printer Status Tab

44

The Printer Status tab displays the printer status, port type, IP address, printer
information, and any messages that apply to the printer.

o If you use printer sharing with a Windows XP client:

= The Printer Status tab may not display status information about the printer.
This does not affect card printing.

* The Print Sample Card, Print Mag Stripe Test Card, and Configure Printer

buttons are disabled.

1. On the Printer
Properties window,
select the Printer Status
tab.

The date and time the
information was
retrieved from the
printer displays in the
lower left area of the
tab.

2. Click Ask Printer for
Update to get the
latest information from
the printer.
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3. You can update printer settings using the printer’s Printer Manager web
service. Click Configure Printer to log into Printer Manager. Refer to your
printer’s Installation and Administrator’s Guide for complete information on

using Printer Manager.

o If your shared printer client PC is connected to the host computer with a USB
cable, the Configure Printer button on the client does not start Printer Manager.
You must configure the printer settings from the host computer.
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Printer Status

The printer status can display as one of the following:

Ilcon

Printer Status

v

Ready
The printer is not processing a card.

"

Suspended

The printer was paused or it is processing a card from another PC
that has an error.

Busy

The printer is processing a card or a command, or the printer
menu system is being used.

Message

The printer has issued a message for a card sent from this PC. The
message text displays.

Initializing
The printer is powering on.

Unavailable
The printer is off, is shutting down, or is not connected.

Port Type

The Port Type displays as:

= USB for a locally connected printer. The printer IP address also displays.

= Network for a printer connected using a network connection. The printer IP
address also displays.

XPS Card Printer Driver Guide
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Printer Information

The Printer Information box shows the following:

Model Model name of the printer

Serial Number Printer serial number assigned at the factory

Firmware Version Version of the firmware currently running in the printer

Protocol DPCL protocol used by the driver to communicate with
the printer

Option Information Options or features included in this printer

Print a Driver Sample Card

46

The Card Printer Driver includes a sample card that shows a basic ID card. The
card can be printed with any ribbon the printer supports. The sample card verifies
that the Card Printer Driver and the printer are communicating. The images and
text do not change.

The Card Printer Driver also includes a magnetic

r——

stripe test card, available when the printer '

includes a magnetic stripe option. The magnetic

stripe test card verifies that the Card Printer

Driver sends magnetic stripe data to the printer

and that the printer encodes it. The data cannot Tiagretic Eivips Tod w‘['i,am

be changed. I i
Ikt g T COMPANY

HINTS & Tips

Trac k) [TT15 data, maa, W04 cham. |
RITMAETEE | st TRt k] DTN | e
TR saditllbiti ol TAGITEE | eee

= The magnetic stripe data sent by the Card
Printer Driver requires that the printer be set
to encode the three-track ISO format for a three-track module, or the JIS-II
format for the single-track module.

= Many driver settings in the Printing Preferences window (such as print area,
orientation, copies, and so on) do not apply to the sample card.

o If you use printer sharing with a Windows XP client, the Print Sample Card and Print

Mag Stripe Test Card buttons are disabled.
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To print a sample card:
1. Open the Printer Properties window.

2. Select the Printer Status tab. If the printer status is not Ready or Busy,
determine why the printer is unavailable.

3. To print a sample card,

o X% Caed Prnter Progesriies i
do one of the following: Gorens | S | Fotn | Advnond | Gk Maragemerd | Secasty | Pt 5t |G Conrt | Sl | Ao
Perter Sl
« Click Print Sample & e
PFos: Typs Mgt - 173 161150
Card. N
Miocled- £0830
. . - B [a[=TT]
= Click Print Mag Stripe s . 031477
Migrata: Qi 150
Test Card. S ot G g e
Freut Sl s hopoer, Extepton st
Lcmrey (rders Palaled
. . f s
The printer picks the card o P o G XU O
and prints it. If the card does Tos
not print, determine the Fon S Gt Par Vg g Tom Gt
cause of the problem and try o ot e Contguen e
. Ladt 1 -] 10D 1 505 M
to print the sample card e
again. o Eaeen
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Card Counts Tab

48

The Card Counts tab of the Printer Properties window shows the number of cards
that have been processed by the printer.

1. On the Printer Properties
window, click the Card
Counts tab. The tab
displays current and total
counts.

2. Click Ask Printer for
Update to see the most
recent card counts.

About card counts:

< Total shows all the cards
the printer has
processed.

Gorensl | Sraeng | Pots | Advariond | Coter Marigmert | Secuty | Pater Stats | Cavd Dourts | Sugpbes | At
o

Pl Haooe Corert Toisl

™ - 45 5 Pcked

= Current shows all cards printed since the last time the count was reset.
Current counts can be reset using Printer Manager.

« The printer only sends updated card counts when you click Ask Printer for

Update.

e The printer includes cards used for test cards and cleaning cards in the Cards
Picked count, but not in Cards Completed count.

= You cannot view card counts from a shared client PC.

« For printers with the optional multi-card hopper, you can select the hopper
for which you want to see the Picked card count.
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Supplies Tab

The Supplies tab of the Printer
Properties window shows the
type of ribbon installed, the
estimated percentage of ribbon "
remaining, and any messages
that apply to the supplies and
printer.

1. Open the Printer Properties
window and click the
Supplies tab.

e |

sl | AT 1110 e

2. The date and time the
information was retrieved
from the printer displays in
the lower left area of the tab. To get the latest information from the printer,
click Ask Printer for Update.

The Card Printer Driver Supplies tab shows the following supply information:

Icon Printer Status

OK

The printer has ribbon, and at least 10% of the roll remains. The
percent of ribbon remaining also displays.

Low
The printer has ribbon, and less than 10% of the roll remains.

Lo

| il
-

Unknown

The ribbon is missing or the printer is not processing a card. The
estimated percentage of ribbon remaining displays as 0%.

&

Ribbon Type

For supported ribbons, the type of ribbon, such as YMCKT or K, is
shown. ymcKT is short-panel ribbon.

If the ribbon is missing or is not a supported ribbon, Missing
displays.
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About Tab

The About tab shows the Card Printer Driver version and any additional
information about the driver.

1. On the Printer Properties

window, click the About e [ ey T [ S5mmemt [k At Sty [t e e g 573
tab. e
I
2. Click OK to close the P R—
Printer Properties
window. Plsters cecyich &) Pagased: Tachvuiogy,
[ox ]| comon
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Uninstall the Card Printer Driver

You can uninstall the Card Printer Driver using either of the following methods:

Uninstall the Driver with the Driver Installation CD or Downloaded File

Uninstall the Card Printer Driver Without the Driver Installation Media
on page 54

You must restart your computer after uninstalling the driver.

Uninstall the Driver with the Driver Installation CD or
Downloaded File

1.

2.

Log on to the PC as a user with administrator access.

Do one of the following:

= Insert the Driver Installation CD in the PC’s drive.

« Double-click the XPSCardPrinter_"version".exe downloaded file.

The Card Printer Driver install Welcome page displays. (If the AutoPlay
window displays, click Run autorun.exe.)

Click the wastebasket icon to start the uninstall process.

The Remove the Printer Driver from the PC window displays. Click Remove
the Driver.

Remove the Printer Driver from the PC

Ly Remowving the diver also deleles all Remaove the Drivar
XP5 Card Prinfers.

Krog the USE canbder plurygond an, of
connecied,

Datacard’
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Datacard

The XPS Card Printer Uninstall dialog box displays. If the printer uses a USB
cable, make sure that the cable is connected to the PC. If the printer connects

to an Ethernet network, you can continue with the uninstall. Click OK to
continue.

# XPS Card Printer Uninstall. [ =

" The USB cable must be plugged in for the driver to be completely
removed.

oK |

An activity indicator displays as the Card Printer Driver is being removed.

Remove the Printer Driver from the PC

. Removing the driver...
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The Driver removed screen displays. If the printer was connected via USB,
unplug the USB cable.

1

X Uinpliy the prcler USH calde, &
connecled, before restating,

Datacard

Remove the Printer Driver from the PC

B Dvivar removed. Restar required.

Restart Now

6. Click Restart Now to restart your computer to complete the driver removal.
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Uninstall the Card Printer Driver Without the Driver

Installation Media

1. Remove the device.

From the Windows Printers window, right-click the icon for the XPS Card
Printer and select Remove device from the pop-up menu. The XPS Card
Printer icon is removed from the list of printers.

o & Drveres s Partary

2. Remove the driver from your system. From the Windows Start menu, select
All Programs > Datacard Printers and click XPS Card Printer Uninstall.

r

Windows Update

3 WinZip

w8 JPE Viewer

ACCERRAES

Adabs

Adakes Deugn Fremuum (&)
Adobe Design Fremium £35.5
Adobe LiveCycle 52
ConelDRAWY Geaphics Suite )15
CutePDF

Datacard Printers

E. PS5 Card Printer Uninstal
Inkel

Ltk B slwcans,
Mantenance

Micrescft Office

Micrasoft Sitlveright

54

Coedault Prograns
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Windows 8 users: On the Start screen, select the XPS Card Printer Uninstall tile,
or type XPS and select XPS Card Printer Uninstall from the Search list.

Click Yes when asked if you want to allow the program to make changes to your
computer.

3. The XPS Card Printer Uninstall dialog box displays. If the printer is connected via
USB, make sure that the cable is connected to the PC. If the printer connects
to an Ethernet network, you can continue with the uninstall. Click OK to
continue.

XPS Card Printer Uni X

'\-I Check that the USE cable is plugged in before continuing this process,

b e
~ TheUSB cable must be plugged in for the driver to be completely
removed,

4. The XPS Card Printer Uninstall dialog box displays a warning that no printer
activity occurs while the driver files are removed. Click OK to continue.

You will be notified when uninstall completes,

It will take about 30 seconds.

Click OK to delete the driver files.

oK |

5. The XPS Card Printer Uninstall dialog box displays a message that the Card
Printer Driver is uninstalled. Unplug the USB cable, if needed. Click OK.

Unplug the printer USE cable now.

oK |
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6. Restart your PC following the uninstall. Click Yes to restart. Click No to restart
your PC at a later time.

XPS Card Printer Uninstall.

~ Restart the PC now?

Yes Mo
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Chapter 4: Card Design Tasks

This chapter provides information about card design tasks you can
perform with the Card Printer Driver.

Use the following information to fine tune your card design and set up your card
printing preferences:

e Change a Card Design
e Design Tasks in Windows Printing Preferences on page 59
e Use Escapes on page 78

e Use Magnetic Stripe Fonts on page 86

XPS Card Printer Driver Guide 57



Change a Card Design

58

Card design is the name given to the combined features of the printed cards.

An organization can change:

The arrangement of card components, such as moving a photo from the
center to the left side of the card.

The source for card components, such as using a different camera for taking
photos, or using a new file for a logo.

The components on the card, such as adding a magnetic stripe, a logo, or a
bar code.

Whenever the card design changes, review the settings used for the card. Use this
checklist to guide your changes. Always:

Use high-quality (300 dpi) photos and graphics.
Print several samples of the updated card design.

Use cards with a magnetic stripe or bar code in a reader to verify that the data
works as expected.

Check the Color Adjustment settings if you change a graphic on the card,
change the camera for taking photos, or change the location where photos
are taken. Refer to “Color Printing” in your printer’s Installation and
Administrator’s Guide for information about how to improve the appearance
on one element on a card.

Refer to your printer’s Installation and Administrator’s Guide if you are
changing a bar code or magnetic stripe.
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Design Tasks in Windows Printing Preferences

The Printing Preferences window allows you to define how your card prints. To
open the Printing Preferences window, display the Printers window on your system.
Right-click the icon for the card printer and select Printing preferences. Use the
Printing Preferences tabs to set up your printing preferences.

Layout Tab

The Layout tab displays when you
select Printing Preferences. You
can select the orientation of the
card (either Portrait or P i g
Landscape) and specify whether
to print on both sides of the card.

S ==

| Lyt | Fart Sews | Color Adkassecs | Fors Mode | Apout

The Advanced button displays the
Advanced Options window, which
allows you to define additional
printing settings. Refer to pre—
“Advanced Options” on page 61
for complete information on
specifying advanced options.

Print on Both Sides of the Card

You can print on both sides of the card using the Card Printer Driver. The method
for printing on both sides depends on the printer model.

e Printers that include a duplex printing module automatically turn the card to
print on both sides. Check the configuration label located on the printer
swingarm to determine whether your printer includes a duplex module. Refer
to your printer’s User’s Guide for more information on reading the
configuration label.

< Simplex printers support manual duplex printing. The printer prints one side
of the card, places the card in the card output hopper, and displays the
message Insert same card side 2 up. Insert the card into the hopper or manual-
feed slot to print on the second side.
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Set Up Duplex Printing

Use card production software or another PC

application to create a card design.

1. Select the card printer as the current printer.

2. Use the application’s page setup options to
set the paper size to ISO ID-1. Set the margin

settings to 0.

3. Format the text and graphics to print on g

the card.

Refer to the printer’s Installation and
Administrator’s Guide for more
information on card design.

4. Open the printer’s Printing Preferences window.

5. On the Layout tab, select Flip on
Short Edge for the Print on Both
Sides setting.

6. Click Apply.

Your PC application’s Print settings may
override the settings in the Card Printer
Driver. Make sure that your application’s
Print settings specify “print on both
sides”.

60
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Advanced Options

Use the Advanced Options window to specify additional print settings. The
following sections describe each of the Advanced options.

Print More Than One Copy of a Card

You can specify to print from 1 to 255 copies of the same card design.

o If you are using a card design application, set the number of copies in the
application. The application settings override the settings in the Printing
Preferences window.

1. Open the Printing Preferences window.

2. On the Layout tab, click Advanced. s s )

3. Type the number of copies you o o e
want to print in the Copy Count ‘ Eﬁii‘ﬁgﬁ”s?"’m"""'
field. You can enter a value
between 1 and 255.

4. Click OK to close the Advanced 6ot Mo b
Tea Clipping: Mafma
Options window. P

5. Click Apply to save your changes
and then click OK to close the
Printing Preferences window.

6. Send the cards to print. [oe ][ coneu

Disable Printing
Use the Disable Printing option to do the following:
e “Encode the Magnetic Stripe without Printing” on page 62

< “Disable Card Side Printing for Special Card Designs” on page 63
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Encode the Magnetic Stripe without Printing

62

Using the Card Printer Driver, you can use the printer to encode magnetic stripe
data on a card without printing on the card.

If you use card production software to produce cards, the following steps are not
necessary. Use the settings in the software to encode the magnetic stripe without
printing.

Open the Printing Preferences window. Select the Layout tab and click
Advanced.

Click Disable Printing and select
All.

'm PS5 Cand Printer Advanced Decument Tettings

L1 PapenOutpen
Click OK to save the setting and ComComeiSamy
close the Advanced Options D T one
window. W;‘ [z e
Rismats frant ids B digress: O3F
On the Layout tab, click Apply. o ot |'“*"9“=“""
Click OK to close the Printing Text Chippingz born]
Preferences window.
The Card Printer Driver discards
all printable data and sends only
the magnetic stripe data to the
printer. ok [ cence
Format the data: By, W v
= If you are using card production St T v A Al seaua,
software, use a magnetic stripe o - =
field if it is available. N
= Using other PC software, format g
the data using magnetic stripe b
fonts or magnetic stripe escapes. m :

The sample card shown has the text

Sports Arts formatted with a magnetic
stripe font. It is sent as encoded data.
The other images and text on Page 1 are discarded.

Send the card to the printer to test your setup.

Card Design Tasks



HINTS & Tips

You are responsible for using characters that the track format supports. Refer to
the printer’s Installation and Administrator’s Guide for magnetic stripe data
formatting information. For more information on using magnetic stripe escapes to
format data, refer to “Use Magnetic Stripe Escapes” on page 81.

Disable Card Side Printing for Special Card Designs

Some card designs require printing on only one side of the card. To avoid printing
on the wrong side or using ribbon for the side of the card with no printing, you
must set the Disable Printing preference.

1. Open the printer’s Printing Preferences window. Select the Layout tab and click

Advanced.
2. Click Disable Printing. TR yw—
3_ Select the D|Sa ble Pr|nt|ng = Jiliipi:lnlr:-:;::;:mamndl'.lmu-mrl Settingy
option that prints the card Paper Sior: Us) ELLIRSAN 2 3538
Copy Count | Sopy
1 Degurnen § Dghians
design correctly and save your B e,
changes. o[

Pring Bur codes i ggp heome Off

Rotate fronk side ¢ &1 180 cegrees: Ot
Retats back wdt ¢ Front 180 degeers: Gff

Split Ribborn: Ho ETTTEIID

Ted Chppeng: Mezmal

Disable
Printing
Option Off All Front Back

2-sided Print side 1 on front No printing | Printside 2 | Print side 1 on
and side 2 on back on back front

1-sided Print side 1 on front No printing | No printing | Print side 1 on
front

The entries in italics are unchanged by the setting. The other settings have the
potential not to print card data if they are used incorrectly.
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Print Bar Codes Using Monochrome

You can set the Card Printer Driver to detect bar codes embedded in an image
and print the image using the K (black) panel of color print ribbon. Refer to the
printer's Installation and Administrator's Guide for the type of bar codes the Card
Printer Driver detects, and for more information on printing bar codes.

Set the bar code detection using
the settings in the Advanced Options
PS5 Cad Panber Advareed Decument Setbengs

window of Printing Preferences. Pgoes Gt
Papee Size: 1501001 (5,60 » 5398 o]
.. Cepy Count: L Copy
1. Open the Printing Preferences 1 Dovumsens Opticrs

# Printer Festures

W|ndOW. Disaible Printing: Off
o )
. Riotate front sade cand image LBD degr qyy
2- CI'Ck Adva nced- Rotste back side card image 160 :It;rE_
Split Ribbon: Mo

Test Clippimg: Hoemal

3. Set the Print bar codes using
monochrome to On.

4. Click OK to close the Advanced
Options window.

5. Click Apply on the Printing
Preferences window.

6. Click OK to close the window.
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Rotate the Card Image

1. Open Printing Preferences.

2. On the Layout tab, click [ 275 Card Prnter Advanced Docurment Selbngs
-+ | PapenTutpis
Advanced. Paper Size: 150101 @560 1 5398 mm)
Copy Count: | Copy
. = Decurment Optcers
3. Select the side of the card you 1y Printer Features
Digaklé Printing: 08f
want to rotate 180 degrees, and Priet s bt uing reonanchisens £
= -
Select On. Rotate back side card image 180 degrees: Off

Split Ribbon: He

Ted Chpgerg: Blommnal

Make sure that if you rotate the
back of the card that the text in
your card design prints below
the magnetic stripe, not on top
of it (see the example card
shown).

o If you are using a card production software, the application settings override the
settings in Printing Preferences. Make sure that you verify that your settings are
correct.

4. Click OK to save the setting, and then

. Ili:\:. T I e ——
click Apply on the Layout tab. o e s e
B e e Ll R ] Eerean i E-d- o mEn
Ty - L Y r|
5. Send the card to print. :_r____‘ ki ‘: ““_j'_"_:’__
2 .

LR A
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Print Cards Using Split-Ribbon Color Printing

Two-sided, split-ribbon color printing uses a single ribbon panel set to print both
sides of a card. This lets you use less ribbon to print cards in color. The ribbon can
be a full-panel or short-panel color ribbon.

Before using split-ribbon color printing, become familiar with the use of card printer
color printing. Refer to the printer’s Installation and Administrator’s Guide for
complete information on color printing.

Most types of cards, including cards with magnetic stripes and smart cards, can
be printed using split-ribbon printing.

The order in which the color, black, and topcoat sections of the panel set are used
to print the card depends on the type of ribbon installed in the printer and the
split-ribbon option selected on the Printing Preferences window. The Card Printer
Driver supports the following ribbon types and split-ribbon printing options.

Ribbon Type Split-Ribbon Printing Options

YMCKT color (YMC) + topcoat (T) front
black (K) back

YMCKT color (YMC) front
black (K) + topcoat (T) back

Note: This option does not apply a topcoat to the
color printing. Color printing fades over time if it lacks
a topcoat.

YMCKT black (K) front
color (YMC) + topcoat (T) back

YMCKT-K black (K) front
color (YMC) + black (K) + topcoat (T) back

YMCKT-KT black (K)+ topcoat (T) front
color (YMC) + black (K) + topcoat (T) back

Before using split-ribbon color printing, be aware of the following:

= Set up your card design with your card production software or a PC
application as you normally do.

= Make sure that you select a split-ribbon option that applies topcoat to the
side of the card where any color printing is used.
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= Make sure that you install the correct ribbon type in your printer. The split-
ribbon option is ignored if the ribbon installed in the printer does not match
the selection in the Advanced Options window.

= When the split-ribbon option specifies only color for a card side, any black
text or monochrome images (including bar codes) on that side of the card are
printed using the color panels to simulate black.

= When the split-ribbon option specifies black, printing on that side of the card
is done only in black, even if the original text and images are in color.

« [If you are using the split-ribbon option with manual duplex printing on a
simplex printer, a message displays on the printer LCD panel each time you
have to flip the card to print the other side. A card may be flipped multiple
times.

To apply split-ribbon color printing:

1. Display the Printing Preferences
window, select the Layout tab,

ST )

o PS5 Card Prister Advanced Document Settings

and click Advanced. Papes/ Qukpk
Baper Sive: 1500 101 (35,60 » $3:58 o)
. R . Copy Count: | Copy
2. Select a Split Ribbon option e Docar o Otions
from the drop-down list. The # s oo 1
default is No, split-ribbon et et ot o oo 1 Bt i
. . « Rotate back side card image LEBO degrees: OF
printing is not used. e B
Text Chppng: o
3. Click OK to save your selection
H YMICKT: K frent + YMCT Back
and then click Apply on the e e
Layout tab- YRICET-KET: KT feonk « YRICKT Back

o [ canes
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Input Hopper

For printers that have an optional multi-card hopper, the Input Hopper setting
allows you to select the hopper to use when you print a card. This setting does
not display for single hopper or manual feed printers. You also can use an escape
to specify the input hopper to use. Refer to “Use Input Hopper Selection
Escapes” on page 83 for more information.

1. Display the Printing Preferences
window, select the Layout tab,
and click Advanced.

WP Card Printer Advanced

o APS Cand Prler Advance d Deowment beltwgs
Papes/Output
B S 150101 (55,60 » 53,08 e
Copy Count: L Capy
=Y Document Dptions
) Bririter Features
Drialbile Prcfang: DI
Print bar codes wing moncchrome Cdf

2. Click Input Hopper and select the
hopper number. The default is

hopper 1. Rustate free side card ienage 180 degress: CF
Robabe beck side card image 180 degrees: (M1
. . Split Ribbor: Mo
3. Click OK to save your selection 1z
. Test Chpping: 1
and then click Apply on the 2
Layout tab. o

5

Text Clipping

You may experience an issue with the clipping of some text characters on your
printed cards. Set Text Clipping to Remove to eliminate character clipping.

1. Display the Printing Preferences
window, select the Layout tab,
and click Advanced.

%P5 Card Princer Advanced plions ==

| AFS Card Printer Acanced Docurrent Settings
Paper/Cutgut
Paper tizes GOV ID-1 IR0 x 2330 mm)
Copy Count: | Copy
s Decument Options
8y Prirtes Festures
Dhaalile Preting: QY
Print bar codes using monochiome O
Rotate front side caed image 180 degrees: Off
Fotate Back side cand image 180 degrees: Off

2. Click Text Clipping and select
Remove.

3. Click OK to save your selection

Split Ribben: Mg
and then click Apply on the el Tl
Layout tab.
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Print Area Tab

The Card Printer Driver can prevent printing and topcoat application on specific
areas of the card. Cards often include a magnetic stripe, a smart card chip, a
signature panel, or other area that must remain unprinted or without topcoat.

The Print Area tab provides a selection of standard blocking patterns that use a
driver pre-set mask, which automatically applies the proper dimensions and
locations of a smart card chip and magnetic stripes for print blocking. For more
information on non-printing areas of a card, refer to the printer’s Installation and
Administrator’s Guide.

If the predefined blocking selections offered by the Card Printer Driver do not fit
the card design, you can use escapes to define custom rectangular areas for
printing and topcoat application, including defining more than one blocking area
per side of a card. Refer to “Use Print Blocking Escapes” on page 78

You also can create a custom topcoat blocking pattern that is not possible with
the topcoat settings offered by the Card Printer Driver or by using escapes. This
can be a non-rectangular shape or another shape based on a graphic image
bitmap, such as a logo. Refer to “Use a User-Defined Topcoat Bitmap” on page
70.

Select a Pre-Set Mask

To select a pre-set mask for magnetic stripe or smart card areas, do the following:

1. Open the Printing Preferences = mmw@
window. (] ™o e T [ !
2. Select the Print Area tab. SRy N

3. Forthe side of the card with the
non-printing area, select Block R eyt i Vo W
printing and topcoat over this area,
and then select the area from the
list.

The Print Blocking icon displays the
location of the card element.
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The example shown blocks ; —
printing and topcoat application T ne [ i Ay || e W™ s

LT - i o L " e L
R o L T LT

on the ISO 3-Track Magnetic
Stripe area on the back of the
card. The text shown on the back
of the card design is formatted
with a magnetic stripe font and is
encoded.

4. Click Apply to save the setting,
and then click OK.

5. Send the card to print.

The back of the completed card looks like the following:

I— A— The narrow white area above and below the
_ magnetic stripe indicates the non-printing
‘ area. ltis slightly larger than the feature, in this
case the magnetic stripe.

Use a User-Defined Topcoat Bitmap

User-defined bitmaps allow you to apply topcoat to a card in a pattern that is not
available in the predefined selections on the Print Area tab or with the
rectangular shapes created with blocking and topcoat escapes. The bitmap files
are installed when you select Legacy Support on the Card Printer Driver
Installation window. Refer to “Install Support Files” on page 20 for more
information. The files are installed in the C:\CardPrinter folder. If you previously
used an older-generation desktop printer, the bitmap files may already be on
your PC.

The topcoat bitmap used depends on the card side and orientation you specify.

Side Orientation Bitmap

1 Portrait CRDPortTopcoatFront.bomp
2 Portrait CRDPortTopcoatBack.bmp
1 Landscape CRDLandTopcoatFront.bomp
2 Landscape CRDLandTopcoatBack.bmp
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Modify a User-Defined Bitmap

Creating a custom bitmap is not recommended. Instead, modify the bitmap files
provided with the driver. The bitmap files are black-and-white, one-bit-per-pixel
files that contain the specifications for blocking. The white areas of the bitmap
represent the topcoat blocking area, and the black area represents the topcoat
areas. Each bitmap has a sample image that illustrates the card orientation. Use a
graphics editing program, such as Microsoft Paint, to modify the driver-provided
bitmap.

. Landscape
EBlook Topoont

Frant

. Landscape
Bloock Tepoont

CRDLandTepeoatEack CROLandTopooat®rom

CROPenTepcoaiBack CRDPenTepooatfromt

The Card Printer Driver looks for the original bitmap file name when using the
bitmap to apply the topcoat. If you want to retain the installed bitmap files as
reference, rename each file using a name that indicates it is the original file. Copy
the file you want to modify and save it using the bitmap name noted above.

1. Open the driver-provided bitmap that describes the card side and orientation
of your card design.

2. Draw a black shape over any sample images you want to remove.

If the card design includes more than one blocking area, you must create all
blocking areas in the bitmap file, including smart card chip or magnetic stripe
areas. Refer to your printer’s Installation and Administrator’s Guide for the
dimensions of non-printing areas for magnetic stripes and smart card chips.
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3.

4.

Create a new blocking area by drawing a white shape or pasting a graphic. The
example shows a possible signature area (below the magnetic stripe area) on
the back of a card. The signature area was created by drawing a white
rectangle on the black background of the file CRDLandTopcoatBack.bmp.

Save the file using the same name in the C:\CardPrinter folder.

Simulate a Hologram

72

Another use for a user-defined bitmap is to simulate a hologram on a card by
blocking topcoat application with a graphic image.

1.

2.

3.

Open the driver-provided bitmap that describes the side and orientation of
your card design with a graphics editing program.

Open a graphic that you want to use as the hologram. This might be a
company logo or another shape.

A. Modify the hologram graphic to create a black background with a white
image.

B. Scale the image to fit the card design.

C. Copy the image and paste it into the bitmap file opened in Step 1.
Remember to take into account any design elements, such as a smart card
chip or a magnetic stripe, where topcoat must not be applied.

Save the bitmap file using the same name in the C:\CardPrinter folder.

HINTS & Tips

If you use a user-defined topcoat bitmap, you must define all card elements in
the bitmap, including smart card chip and magnetic stripe locations. Driver-
defined pre-set masks or ID software topcoat blocking areas are not used.

The purpose of topcoat is to protect the printed image on a card. Any area
with color printing eventually fades if it lacks a topcoat. Make sure that most
color printing is covered with topcoat.
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Select a User-Defined Bitmap

1.

Open the Printing Preferences

T L L pp S ——

window.

] laymaki| Pt S Coior At | Ford Mol | Ao

Select the Print Area tab. SISy i

For the side of the card that you

want to use the user-defined ‘ s gt i, Ly v

bitmap, select Ignore topcoat

selection. Use my bitmap for AR it
topcoat. The Topcoat icon displays | PR St . =
as BMP.

The driver uses the correct bitmap
based on the card orientation you
specified on the Layout tab.

Click Apply to save the setting, and
then click OK to close the Printing Preferences window.

Send the card to print.

Check the card to verify the topcoat is being applied correctly. Print sample
cards until you are satisfied that the topcoat meets your card design
requirements.
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Color Adjustment Tab

Brightness

74

The Card Printer Driver allows you to adjust the color printing on a card using the

Printing Preferences window.

Using the Color Adjustment tab, you can change the following:

« The brightness of color printing on the card

« The contrast of color printing on the card

e The color balance of color printing
on the card

1. On the Printing Preferences
window, select the Color
Adjustment tab.

The tab contains the Original
image and the Adjusted image.
They show how your changes
might look on a card.

2. Select Enable Color Adjustment
to adjust the settings.

The Brightness setting changes
the overall lightness or darkness
of the card.

1. Click the Up arrow to make
the image lighter, or the
Down arrow to make the
image darker.

The Adjusted image shows
the effect of the new setting.

2. Click Apply after each
change to save it.

o Eratr e bt
L o —

Y s

Layrn | Pt dyws | Toor At | oy bote | Spoc
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3. To verify changes, do one of the following:

e Print one or more cards from your card production software.

e Print a sample card from the Printer Properties > Printer Status page.
4. Evaluate the appearance of the cards.
5. Repeat these steps until the cards meet your requirements.

6. Click Apply to save the new values.
Contrast

The Contrast setting changes
the degree of difference
between the light and dark
values of an image.

1. Click the Up arrow to
increase contrast, or the

Down arrow to decrease

contrast.

The Adjusted image shows
the effect of the new
setting.

2. Click Apply after each
change to save it.

3. To verify changes, do one of the following:

e Print one or more cards from your card production software.

* Print a sample card from the Printer Properties > Printer Status page.
4. Evaluate the appearance of the cards.
5. Repeat these steps until the cards meet your requirements.

6. Click Apply to save the new values.

Color Balance

1. Evaluate the image for color balance. Does the card have a yellow cast or do

photos have a greenish tint?

If most of the card prints with the correct colors, consider using a graphics
application to change the logo or other part of the card that needs color
improvement.
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2. Determine which color needs
adjustment.

Click the Up arrow to increase a
color, or the Down arrow to
decrease the color.

e The Adjusted image shows
the effect of the new setting.

= If changing the obvious color
does not produce the
desired effect, try changing
the other two.

3. Click Apply after each change to
save it.

4. To verify changes, do one of the
following:

e Printone or more cards from
your card production software.

e Print a sample card from the Printer Properties > Status page.
5. Evaluate the appearance of the cards.
6. Repeat these steps until the cards meet your requirements.
7. Click Apply to save the new values.
HiNTs & TipPs

« The settings on the Color Adjustment page affect the color printing of all cards
sent from the PC that uses the Card Printer Driver.

= Text and images formatted as black (K) are not affected by color adjustment.
e Each click changes the setting by 1 percent (%).

< To use adjusted colors on some cards but not others, clear the Enable Color
Adjustment selection before you print the cards that do not need the
adjustment.
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Print Mode Tab

The Print Mode tab allows you to specify the print resolution to use when printing

a card.
1. Open the Printing Preferences ~ - :
window. L | Pt .| G | Pt e |

W Mewn Lse Barthes reneon (00 X0 dnd

2. Select the Print Mode tab.

S a8 (= [ i Tar

3. Select the desired print resolution. e
The Print Mode tab has the
following three options.

All options may not be available
for all printers.

« Always use standard resolution
(300x300 dpi)—this is the
default value

= Always use best resolution (This
option is not available at a
shared printer client PC.)

e Custom
If the Custom option is available and you © Custom
select it, select the resolutions from the 50300 21 Color
Color and Monochrome drop-down lists S

300x 300
4. Click Apply to save your changes, and then click
OK to close the Printing Preferences window.

XPS Card Printer Driver Guide 77



Use Escapes

Escapes are formatted text that the Card Printer Driver converts to support print
blocking, topcoating, magnetic stripe data encoding, hopper selection, and
embossing.

HINTS & Tips

For each escape, make sure that the text is consistent (same font, size, color).
Use a common font that is easy to see, and differentiate from, the text you
want to print on the card.

Each escape must be on a single line with no formatting. Use a small font size
to make sure that there is adequate room for long escapes.

Do not align escape text to be on the same horizontal line as printed text.

Make each escape its own line of text on the card design.

Use Print Blocking Escapes

The Card Printer Driver provides several methods to prevent printing and topcoat
on specific areas of the card. Refer to “Non-Printing Areas” in your printer’s
Installation and Administrators Guide and “Print Area Tab” on page 69 for more
information.

By default, the entire surface of the card is available for printing and topcoating.
But when cards have a magnetic stripe, a smart card chip, or another non-
printable area, such as a signature panel or hologram, you must define those
areas so that the printer does not print or apply topcoat to them.

To block non-standard areas, or for more than one blocking area per side of a
card, use escapes to define the print areas. Escapes are specific sequences of
characters that mark data with a special purpose. The Card Printer Driver
recognizes the following types of print blocking and topcoat escapes:
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Block Print
Topcoat Add

Topcoat Remove
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About Non-Printing Areas

If the card has more than one non-printing area on a side, define all non-printing
areas using print blocking escapes. An escape applies to the side of the card
where it appears in the document.

Non-printing areas defined using print blocking escapes always override the
driver Printing Preferences settings.

Each print blocking area is a rectangular shape.
Print Blocking Syntax

The syntax or structure of each print blocking escape is “XX%n1n2n3n4? where:

e “~isth inni fth .
is the beginning of the escape ~XX%n1n2n3n4?

= XXrepresents the type of action — T—End of statement
Block Print (PB), Topcoat Add (TA), Height of area
Width of area
or Topcoat Remove (TR). Distance from left
Distance from fop
e % indicates the start of values. Start of values
Type of action
o All of the following values — Beginning statement
are in mm.
Left =0
e nlisthe distance from the top of L Widith = 85.6 .
the card to the start of the area. Top = imm -
Height =1ts.a

e n2isthe distance from the left
edge of the card to the start the
area.

e n3is the width of the area.
e ndis the height of the area.

= ?isthe end of the escape.

The card in the example shows the dimensions of a three-track magnetic stripe
area.
Blocking typically extends 0.1 inch (2.54mm) beyond the edges of a feature. The
dimensions listed include the extended blocking region.

The escape can specify more than one area of the same type by placing a
semicolon (;) character between each set of values.
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Block Print Escape
A block print escape begins with “~PB%

Examples:

~PB%10 10 55 157 Printing is blocked in one area.

~PB%10 10 5 5;30.5 45.23 15 15? Printing is blocked in two areas.

~PB%? No printing is blocked.

Topcoat Add Escape

The topcoat add escape prints topcoat only in the area defined in the escape.
Topcoat is not applied to other areas of the card. All full-color printing should be
covered with topcoat, so use this option with care.

The topcoat add escape begins with ~“TA%

Examples:

~TA%0 0 85.6 377 Topcoat is applied to one large area of
the card.

~TA%16.8 0 37.1 5;30.5 45.23 15 15? | Topcoat is applied in two areas.

Topcoat Remove Escape

With a topcoat remove escape, the topcoat is not applied to the areas defined by
the escape. All other areas of the card have topcoat.

The topcoat remove escape begins with “TR%

Full-Card Topcoat Options

e Use the escape ~“TR%? to override the Card Printer Driver preset masks and
topcoat the entire card side.

e Use the escape ~“TA%? to override the Card Printer Driver preset masks and
apply no topcoat to the entire card side.

Print several cards using your card design and application to verify that printing
and topcoat are applied as you intend.
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Use Magnetic Stripe Escapes

The data to encode on a magnetic stripe is entered as text and can look like data
to print. The Card Printer Driver uses magnetic stripe escapes to identify the data
to encode. Data contained within the escape is not printed.

Set Up Magnetic Stripe Escapes
1. Use card production software or another application to create a card design.
2. Format the text and graphics to print on the card.

3. Type the encode data (text) for one track. Locate an area on the card where
typing the data to encode does not affect other card design components.

The example shown uses the syntax:

. : 2 oocment eomatwos |
<track#><Start Sentinel><Data> <End T T
Sentinel> M Tomtewioan «% + B 7 ) EETE S

The text for track 1 has the format:
~1%Zachary Hamilton 12345 Finance?

Zachary Hamilto
< Do not put data for two tracks on the T

Dy 12345

same line. .
Fz.l‘ I.t.'v'll1‘|.‘-_":.'| 12345 Foanee
= NERVRREN]
« Do not allow the text to encode to D YA P01 25 ) LA TR0 T4

wrap to another line. Use a smaller . |
font size to keep the text on one line.

= If necessary, you can use two or more lines of text for one track. Start and
end each line with escapes, and enter a carriage return at the end of the
line. The Card Printer Driver adds (appends) lines for the same track
together.

= Data to encode can be on side 1 (front) or side 2 (back) of the card.

« Do not enter data to print on the same line as data to encode. It will not
print.

4. Repeat Step 3 for each track of magnetic stripe data.
5. With magnetic stripe cards in the printer, send the card to print.

6. Verify that the encoding was successful by passing the card through a
magnetic stripe reader.
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Supported Escapes
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The escape defines the track for the data. Because the data format for each track
is set in the printer, you must enter the type of data the format requires. The Card
Printer Driver supports several escape systems to allow compatibility with various
card printers. The table below shows the default ISO data format for each track.
The Syntax column shows the general escape format for providing data to the
printer. The Example column shows how the data looks when formatted.

Syntax Track Example
~<track#> <Start Sentinel> <data> 1 (IATA) ~1%ENCODING WITH ESCAPES?
<End Sentinel>

2 (ABA) ~2;12345678907?
The only Start Sentinel permitted for _ -
tracks 2 and 3 is a semicolon (;) 3 (TT9) ~3;1234567890"
Used by: Datacard RP90 and SR Series,
JVC, and Fargo printers
~<track#><data> 1 (IATA) ~1ENCODING WITH ESCAPES
Used by: Eltron/Zebra printers 2 (ABA) ~21234567890

3 (TTS) ~31234567890
~<track#>=<data> 1 (IATA) ~1=ENCODING WITH ESCAPES
Used by: Atlantek printers 2 (ABA) ~2=1234567890

3 (TTS) ~3=1234567890

HINTS & Tips

= Use a small font size to shorten lines of text to encode.

= Keep text to print on a different line from text to encode.

= When the Card Printer Driver adds lines of text for the same track, the
sequence is determined by the application. Test your application with the
Card Printer Driver to make sure that the data is in the correct order.

= Magnetic stripe data sent by the Card Printer Driver is always encoded on

side 2 of the card.

= Magnetic stripe data is converted to uppercase letters if needed.

= If characters unsupported by a track format are sent within the magnetic

stripe data, the printer displays a message.
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Use Input Hopper Selection Escapes

Some printers offer an optional multi-card hopper that has six input hoppers,
each holding 100 cards. The Card Printer Driver allows you to specify the number
of the hopper to use on the Advanced page of the Printing Preferences Layout tab.
However, this option applies the hopper selection to all cards sent to the printer.

Using a hopper selection escape allows you to specify the input hopper to use as
part of each print job from any application.

Input Hopper Selection Syntax

The syntax for an input hopper selection escape is Y"HS%x?, where:

~ indicates the start of the escape.

HS tells the Card Printer Driver that it is a hopper selection escape.

% indicates the start of a hopper value.

x specifies the hopper number to use. x can be any value between 1 and 6.

?is the end of the escape.

For example, the escape “HS%5? tells the Card Printer Driver to pick a card from
input hopper 5 for the print job.

HINTS & Tips

The input hopper selection value specified by the escape overrides the value
set on the Printing Preferences Layout tab.

If a printer does not have a multi-hopper, the escape is ignored. The card
prints from the single hopper, or manual card input slot. No error is logged or
displayed.

If the value of x is anything other than 1, 2, 3, 4, 5, or 6, the escape is not
detected and the escape prints on the card as regular text.

The escape sets the printing preference for the input hopper by job. The
application you use determines how the escape is interpreted:

< Some applications, such as Microsoft Word, send a multipage, multicard
document as a single job. The driver uses the first escape it encounters for
all cards in the job. Any other valid escapes are ignored.

e Card production applications usually send a separate job for each card.
This allows you to specify a different hopper for each card in a batch of
printed cards.
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Use Embosser Escapes

Use an embosser escape to specify the font and position of embossed and
indented data. An embosser escape is made up of the following elements:

« Escape preamble—Tells the Card Printer Driver that the text characters
following are part of an embosser escape and not text for rendering on the
card.

< Embosser font number—CE Series systems use a font number to specify the
emboss or indent character set, the front or back of the card, and in some
cases the supply to use.

= Emboss/Indent position—Two values that specify the starting location of the
emboss/indent operation.

< Emboss data—The text to be embossed or indented at a given location using
the font number specified.

Embosser Escape Syntax
The embosser escape syntax is: “~EM% font#; horz_offset; vert_offset; data
Use a semicolon (;) character to separate embosser escape elements.
Escape Preamble

In the preamble, the characters YEM% identify the beginning of an emboss
escape.

Embosser Font Number

The usable font numbers are based on the emboss wheel installed in CE Series
systems. Several fonts from the following list typically are supported by a given

wheel:
1= Emboss Standard Gothic [front 10 cpi]
2= Emboss Farrington 7B [front 7 cpi]
3= Indent OCRB [back 10 cpi]
4= Indent Master Card Slanted [back 14 cpi]
5= Indent OCRB Size IV [front 7 cpi]
6= Indent Master Card Slanted [front 14 cpi]
7= Indent OCRB Front [front 10 cpi]
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8= Indent Master Card Inverted [back 7 cpi]

9= Indent Helvetica [front 14 cpi white ribbon]*

10= | Indent Helvetica [front 14 cpi black ribbon]*

* Note: Add 20 decimals to override default side.

Emboss/Indent Position

The position of the start of the emboss or indent data.

horz_offset Whole number in mils (1/1000 of an inch) from left
edge of card to center of first character

vert_offset Whole number in mils (1/1000 of an inch) from bottom
edge of card to the vertical midpoint of the
characters

The following restrictions apply to the horizontal and vertical offsets.

Horizontal Offset Limits

Topping Maximum Value Minimum Value
on 3025 280
off 3275 100

Vertical Offset Limits

Topping Maximum Value Minimum Value
on 860 135
off 1460 135

Emboss Data
CE Series systems have restrictions for the characters allowed.
e The emboss data range is from 20 hex to FF hex.

e Reserved XML characters (3c hex and 3e hex) are not allowed as emboss
characters.

= For data greater than 127 ASCII, an escape must be used (for example, &#181;
is used to emboss a Katakana character [B5 hex]).
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Use Magnetic Stripe Fonts

The Card Printer Driver provides fonts to format magnetic stripe data. Use these
fonts when magnetic stripe escapes cannot be used.

1. Use the application’s page setup feature

to set the paper size to ISO ID-1. Reduce | — "~ e
the page margins to match the card mj i r:":‘um:. n.-:a...~.:l':4:":: ; =
design. e | L— ||
g e e e
2. Format the text and graphics to printon |
the card.
- e Zachary Hamiltan
3. Type the data to encode using a standard L= 0 12

font, such as Arial.

e Use a small font size to minimize the
amount of space used for encoded
data.

« Do not put data for two tracks on the same line.

« Do not allow text to encode to wrap
to another line.

moan | e Pegriiyedd  Remraen Miege
&

By 933 -
B

it Porm Bomas I | e o | ,N: 1z~

o e
- Datato encode can be on side 1 S E e s o s
pesmd v -l

(front) or side 2 (back) of the card. ,a_’—‘“““‘

4. Add an extra space character to the end
of the data.

Zachary Hamilton
[ R ritl]

5. Select a line of data up to, but not fogyeia o a8

including, the extra space characterand | — " "¢ e e mew
; R LTI U S  T
apply one of the following fonts: o =
b s Cambria W: )
= Mag Track 1 XPS Card Printer Cabbn L

oty (e Fosty
% Mag Track 1 XPS Cand Printe
F Mag Track 3 XPS Card Printe
T Maqg Track 2 XPS Card Printe
*® Anal -
% Lucida Havdwriting

% Lucida Bright

= Mag Track 2 XPS Card Printer l

e Mag Track 3 XPS Card Printer

e Mag Track JIS XPS Card Printer

LR T R TR IR
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6. Repeat Steps 3 through 5 for each line of text to encode.
7. Send the card to print.

8. Verify that the encoding was successful by passing the card through a card
reader.

HiNTs & TiPs

= Do not use character formatting, such as kerning.

= Do not use smart quotes.

= Use a small font size to shorten lines of text to encode.

= Keep text to print on a different line from text to encode.

e When the Card Printer Driver adds lines of text for the same track, the
sequence is determined by the application. Test your application with the
Card Printer Driver to make sure that the data is in the correct order.

= Magnetic stripe data sent by the Card Printer Driver is always encoded on
side 2 of the card.

= Magnetic stripe data is converted to uppercase letters if needed.

= If characters unsupported by a track format are sent within the magnetic
stripe data, the printer displays a message.

If you have an existing application that uses magnetic stripe fonts from older
generation printers, the Card Printer Driver recognizes these fonts. If they are not
installed, use the “Legacy Support” option on the driver installation Support Files
screen to install them. Refer to “Install Support Files” on page 20 for more
information.
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Chapter 5: Installation
Troubleshooting

This section describes:
e Troubleshoot the Card Printer Driver Installation

e Use Advanced Troubleshooting Tools on page 92

The Card Printer Driver Installation CD is provided in the CD Folder included in the
shipping carton. If the CD is not available, you can download the driver from
http://www.datacard.com. Select Support & Drivers > Drivers & Download from
the menu. Enter your printer model in the Enter Product Name or Number area,
and click Go.

Troubleshoot the Card Printer Driver Installation

This section describes issues that could prevent a successful installation and
provides recommended solutions to those issues. Choose from the following
topics:

e USB Installation Troubleshooting on page 90

< Network Installation Troubleshooting on page 92
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USB Installation Troubleshooting
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Problem

Solution

The cable is loose.

Reconnect the USB cable to the ports on the PC and
the printer. Power the printer OFF, and then back ON.
If the PC and printer still do not communicate, restart
the PC.

The data cable is
damaged or frayed.

Power off the printer. Replace the cable if you have
a spare. Contact your service provider to order a
new data cable.

The system has a
temporary
communication
problem.

Check the following:

- USB extension cables can cause
communication problems. The recommended
USB cable is 6-ft. (2 meters) long. Make sure that
the cable is rated for USB 2.0 data transmission.

- If you are using a USB hub, a self-powered hub
is recommended.

The card printer does
not install when the USB
cable is connected.

If a previous printer installation attempt was
unsuccessful, Device Manager might still show an
entry for the printer.
Remove the printer entry from Device Manager
before reinstalling the printer:

1. Disconnect the printer from the PC.

2. Open the Windows Device Manager.

3. Locate the device to delete. The device might
be called “Unknown device” or it might be
located under the Printers or Network Adapters
folder. The device might be marked with a
yellow question mark or exclamation point.

4. Select adevice name, and right-click to display
a pop-up menu.

5. Select Remove from the pop-up menu.

6. Click Yes or OK to confirm removal of the
device.

7. Close the Device Manager. Close any other
windows.

8. Reinstall the printer.

Error message states
the USB is not
detected.

The USB installer timed out before a printer was
detected.

Remove the Card Printer Driver from the Device
Manager before reinstalling the printer.
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Problem

Solution

The USB cable is
connected before the
Card Printer Driver is
installed.

The first printer installed on a PC using a USB
connection must be installed from the driver CD or
downloaded Card Printer Driver.

Connect the USB cable to the printer when you are

prompted. Do not connect the cable before starting
the installation.

The Print Sample Card
button is inactive.

The Print Sample Card button in Printer Properties is
enabled when the printer and Card Printer Driver
communicate normally. If Print Sample Card is
inactive (gray), make sure that the User button on
the printer front panel is steady green and that Ready
displays on the LCD panel.

The Print Sample Card button is not available when
printer pooling is enabled.

The PC USB port does
not communicate with
the printer USB port.

Power management on the PC has shut down USB
communication. Check the following:
= Open Windows Device Manager and display
the list of USB devices. Disable shutdown for
each hub in the list. Restart the PC for the
changes to take effect, if necessary.
= Hibernation on a laptop PC requires several
moments to enable USB communication. Unplug
the USB printer port and then connect it again.
= Replace the PC port or the PC. Contact your PC
or port vendor if you need assistance.

The printer does not
install or print on the PC
when the PC is
connected to a
remote network using
VPN Client software.

VPN Client software can prevent the installation and
use of other devices. Choose one of the following
solutions:

= Configure your VPN software to allow local
network connections.
e Disconnect the VPN Client software from the

network, and then install the USB printer and
Card Printer Driver, or resume printing.
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Problem

Network Installation Troubleshooting

Solution

The network cable is
loose.

Reconnect the data cable to the network port and
the printer, making sure that it is snapped in. Restart
the printer.

The Status page of
Printer Properties shows
the printer is not
available, but the
printer displays Ready
on the LCD screen.

Follow your network troubleshooting procedures to
isolate and test each component of the computer-
to-printer communication link.

Suggestions:

e Check the computer-to-network connection by
accessing a network resource, such as a
network drive.

e Have the network administrator check
communication between a server and the
printer.

= Make sure that the user is logged in to the
network.

The printer is not
configured with the
correct network
address.

Make sure that the server name or IP address has
been entered in the Port Settings or Configure Port
dialog box on the computer. For information on
retrieving the printer’s IP address, refer to the card
printer’s User’s Guide.

Make sure that Ready displays on the printer's LCD
panel.

Use Advanced Troubleshooting Tools

For additional troubleshooting topics, refer to the printer’s User’s Guide.

The Printer Manager also provides access to additional troubleshooting tools.
Refer to the your printer’s Installation and Administrator’s Guide for information
about using the Printer Manager.
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Appendix A: Windows 7 and
Windows 8 Printer Sharing

This appendix provides information about how to
install and share the Card Printer Driver on a PC
running the Windows 7 or Windows 8 64-bit
operating system.

Windows 7 or Windows 8 Installation

Printer sharing involves setting up the host PC for sharing, then installing and
setting up the Card Printer Driver on each client system that prints to the printer.

Set Up the Host PC for Printer Sharing

1. Install the XPS Card Printer Driver on the host PC. Refer to “Install the
Driver” on page 8.

2. Configure the host PC for printer sharing.

A. From the Windows Control Panel, select Network and Internet > Network
and Sharing Center.

B. Select Change advanced sharing settings from the left column. The
Advanced sharing settings window or the Network profile options display. If
the Advanced sharing settings list displays, select the network profile you
want to work with.

o The Advanced sharing settings display varies depending on a system’s setup.
In addition, based on its setup, a system may open one of the profiles and
display the options shown in step C.

C. On the Network profile options page, select the following options (these
are the default settings).

Field Select option

Network discovery Turn on network discovery

File and printer sharing Turn on file and printer sharing
Password protected Turn on password protected sharing
sharing
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D.

If you selected (turned on) any options in this step, click Save changes.
Close the Network and Sharing Center window.

3. Enable printer sharing.

A

0

Open the Devices and Printers window and right-click the card printer icon.
Select Printer properties to display the Printer Properties window.

Allow printer sharing.
i.  On the Printer Properties window, select the Sharing tab.

ii. Select Share this printer. The printer name displays in the Share name
field. Write down the printer name.

Remember to record the printer name and host PC name. You need these
names to install the Card Printer Driver on the client PC. For more about
printer names, refer to “Use device naming rules for shared printers”
on page 30.

ii. Select Render print = =

jobs on client
computers. s W A, o v e s s

r*‘; wwel prwsprd For Py computes Com prond 13 8. T prostey sall vt

e Fory Fol | biewied | oo Hesgeewi | Sy | Seiw Sma | Dot Certn | Sguden | s

B sl whs Tht COPTpubir mieege. To dRange hans BfTe

iv. Click Apply to store
these settings.

e B shared wed e roes) Sfteent senone of
ou Ty el e il dditetrad dewrmy, i thal

Keep the Printer Properties window open while you find the full computer
name in step C below.

Find the host PC full computer name and write it down.

i. From the Windows Control Panel, select System and Security >
System.

ii. Write down the name of the computer found in the Full computer
name field on the System window.

ii. Close the System window.

Windows 7 and Windows 8 Printer Sharing



4. Configure security for sharing printing and viewing print error messages.

A. From the Printer Properties window, select the Security tab.

B. Review the Group or

i3, YP% Card Printer Propertics =
user names list. Make e e e e P e e e e
sure that the default ;
settings on the Security
tab have the following Jroslibpr sy S
printer-sharing
permissions:
= Everyone has Print R — ®m
permission set to @y
Allow (refer to the i
figure at right).
- Only CREATOR . Far bl pammisnons or advincad iingt. chak Advanced rwey)
OWNER has
Manage —
documents

permission set to
Allow. This lets the owner both view printer error messages and
perform document-related administrator tasks at the PC.

C. If you made any changes, click Apply to save your updates.

D. Add users or groups.

From the Security tab, click Add. The Select Users or Groups dialog box
displays.

Click Advanced and then Object Types.

Select the check boxes for Users and Groups and click OK. The Select
Users or Groups dialog box displays.

Click Find Now. A list of user and group names displays.

Select each name to add and click OK. The name(s) you selected
display in the Select Users or Groups dialog box.
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E.

vi. When you finish adding names, click OK. The names display on the
Security tab. Each name you added has Print permission.

vii. If you want to revoke Print permission and prevent a user or group
from printing, select the user or group and clear the Allow check box
for the Print permission.

Do not select the Manage documents or the Deny check boxes for any user
or group. Only the CREATOR OWNER should have Manage documents
permission set to Allow, which is the default.

Allow users or groups to view printing error messages.

i. From the Security tab, select a user or group and select Allow for the
Manage this printer permission.

ii. Repeat for each user or group.

iii. Click Apply to save changes for each name.

5. Set up Windows printing for card design.

A.

From the Devices and Printers window, right-click the card printer icon and
select Printing preferences. The Printing Preferences window displays.

Enter your printing preferences. Refer to “Design Tasks in Windows
Printing Preferences” on page 59.

Write down the printing preferences settings for split-ribbon color
printing, topcoat and print blocking, and print resolution.

These settings are not set automatically at the client PC to match the host. You
must enter these settings manually on each client PC when you set up printing
preferences. For an overview, refer to “Configure PC Printing Preferences for
Sharing” on page 30.

Click OK to close the Printing Preferences window.

Windows 7 and Windows 8 Printer Sharing



Install the Card Printer Driver on the Client PC

The following instructions may vary slightly based on the operating system of the
client PC. Refer to “Printer Sharing Requirements” on page 26 for a list of
supported host/client operating system combinations.

1. Make sure that the Card Printer Driver is installed and set up on the host PC.

2. Log on to the client PC with a user account that has administrator privileges
and matches an account and password on the host PC.

= Start at the Login screen of the client PC and review the user names
displayed. Look for a user with administrator access that matches a user
name on the host PC. If one is not listed, set up a user account and
password on the client PC to match an administrator account from the
host PC.

OR

e Logon to the host PC from the client PC using a network access as follows:
e Use Windows File Explorer or My Computer to locate the host PC.
e Select the host PC. The Enter Network Password dialog box displays.

« Enter your password and click OK. The host PC desktop displays.

You must log on to the host PC across the network by using a different user
account than was used to install the printer on the host.

After you log on to the host PC using the network, keep the window open
until the installation completes.
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3. Add the Printer to the client PC.

A. Open the Windows Devices and Printers window.

B. Select Add a printer.
The Add Printer window

) =) Add Printer

displays.

C. If you use Windows 7:
Select Add a network,
wireless, or Bluetooth
printer.

The system displays a
list of available

prin
printers.
D. If the printer does not
display in the list:
i. Select The printer
Next Cancel
that | want isn’t  — —

listed. The Find a
printer page displays.

What type of printer do you want to install?

9 Add a local printer
Use this option only if you don't have a USB printer. (Windows automatically installs USB printers
when you plug them in.)

2 Add a network, wireless or Bluetoath printer
Make sure that your computer is connected to the netwdfk, or that your Bluetooth or wireless

i. Inthe Select a shared printer by name field, enter the name of the
host PC and the shared printer name following this format:

\\host PC name\shared printer name

o Use the names you wrote down during the host PC installation in step 3B.

jii. Skip to step E.

Windows 7 and Windows 8 Printer Sharing



iv. If you don’t have the printer name, enter the host PC name. Use the
format:

\\host PC name\

When you type the last
backslash without a

. . b = iirom
printer name, a list of
host printers displays in a
drop-down list. | Otmotrapms
v. Select the name of the MG boea
T

card printer for sharing.

E. Click Next. If the Do you trust
this printer? dialog box
displays, click Install Driver.

Windows installs the Card

Printer Driver. The message . let || Coudl
“You’ve successfully added
printer name” displays when the installation is complete.

F. Click Next. The “To check your printer” message displays.
G. Click Finish to close the Add Printer page.

4. If card production software is installed on this computer, or if you need other
support files, such as magnetic stripe fonts, install the Printer Plug-in or
support files from the Driver Installation CD. For instructions, refer to “Install
Support Files” on page 20.

5. Set up Windows printing for card design.

A. Get the printing preferences settings you wrote down at the host PC for
the split-ribbon option, topcoat and print blocking, and print resolution.

These settings are not set automatically at the client PC to match the host,
so you must enter them manually.

B. From the Devices and Printers window, right-click the card printer icon and
select Printing preferences. The Printing Preferences window displays.

C. Enter the required printing preferences. Refer to “Configure PC Printing
Preferences for Sharing” on page 30 and “Design Tasks in Windows
Printing Preferences” on page 59.

D. Click OK to close the Printing Preferences window.
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Appendix B: Windows XP
Printer Sharing

This appendix provides information about how to
install and share the Card Printer Driver on a PC
running the Windows XP, 32-bit operating system.

Windows XP, 32-bit Installation

Printer sharing involves setting up the host PC for sharing, then installing and
setting up the Card Printer Driver on each client system that prints to the printer.

Set Up the Host PC for Printer Sharing

1. Install the Card Printer Driver on the host PC. Refer to “Install the Driver” on
page 8.

2. Clear simple file sharing on the host PC.

Make sure that you clear (turn off) simple file sharing while setting up the host PC
for file sharing. Simple file sharing causes certain features, such as the Security
tab, to be hidden. You must be able to display the Security tab to configure
security later. You turn on simple file sharing again after setup is complete.

From the Windows Start menu, click

My Computer. If needed, click Explore.

The My Computer window displays.
Click Tools and select Folder Options.

Select the View tab

D. Inthe Advanced settings list, scroll to

Use simple file sharing
(Recommended) and clear the
selection.

Click OK to save your changes and
close the Folder Options window.

Close the My Computer window.
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3. Open the Printers and Faxes window.
4. Write down the printer name and the host PC name.

A. From the Printers and Faxes window, write down the name of the newly
installed card printer.

Remember to write down the printer name and the host PC name (see below).
You need these names to install the Card Printer Driver on the client PC. For
more about printer names, refer to “Use device naming rules for shared
printers” on page 30.

B. Find the host PC name.
i. Open the Windows Control Panel.
ii. Double-click System and select the Computer Name tab.

ii. Write down the name shown in the Full Computer Name field. You
must enter this as the host PC name when you install the printer at the
client PC.

iv. Click OK to close the System window.

5. On the Printers and Faxes window, right-click the card printer and select
Properties to open the Printer Properties window.

6. Enable printer sharing.
A. Select the Sharing tab on the Printer Properties window.

Depending on your network configuration, the Sharing tab may display
with a statement that remote access is disabled.

& 1% Caidl i dster Prapariies

Giwasel PP Piae | Aewmied | Lo ol gt | Prukis s | T Comirts | ol | it

1 5 Cad Pt

v Lace

i. Click If you understand the risks but want to share printers without
running the wizard, click here.
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ii. When the Enable Printer Sharing dialog box displays, select Just enable
Printer Sharing, and click OK.

' Il e bl phannag on e Compubes veifoul unrg e Hetvead,

4 :'I Seslup Wizard, the compuies could be v able 1o shack s bor
e Inbesred ‘we wpongly secommend Bl you nn The Netveord:
Setup Wizad b peobech poun compale
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B. Select Share this printer to enable sharing. Write down the printer name
that displays in the Share name field.
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C. Click Apply to apply the printer sharing settings.
7. Configure security.
o Skip this Configure security section if you want to accept the following defaults:
= All users (the Everyone account) can print, and

e Only the person who enabled sharing on the printer (the
CREATOR OWNER account) can view printer error messages at the
client PC.

Users at the client PC can view printer error messages from the Windows
Print Manager. These printer errors can be resolved at the printer LCD screen or
host PC.

For more information, refer to “Security permissions for shared printers” on page
28, and “View message boxes” on page 28.
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A. Select the Security tab on the Printer Properties window.

B. Review the Group or user names list. If the names or group for which you
want to specify permissions do not appear in the list, add the names or
create a group:

i. Click Add to display the Users and Groups dialog box.

ii. Selectthe name you want to add, and click Add. Repeat for each name
you want to add.

ii. When you are finished adding names, click OK to close the Users and
Groups dialog box.

C. Assign print permissions.

i. From the Group or user names list on the Security tab, select the name
or group to be assigned permissions.

o Do not select the Manage documents or the Deny check boxes for any user
or group. Select Allow for Manage Printer if you want a user or group to
view message boxes.

ii. Select Allow for permissions you want to apply to the user or group.

iii. Clear the Allow check box for permissions you want to deny the user
or group.

iv. Click Apply to save your changes. Make sure that you save changes for
each user or group.

8. Enable bidirectional support.
A. Select the Ports tab on the Printer Properties window.
B. Confirm that Enable bidirectional support is selected.
C. Click OK to close the Printer Properties window.

9. Set up Windows printing for card design.

A. From the Printers and Faxes window, right-click the card printer icon and
select Printing preferences. The Printing Preferences window displays.

B. Enter your printing preferences. Refer to “Design Tasks in Windows
Printing Preferences” on page 59.
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D.

Write down the printing preferences settings for split-ribbon color
printing, topcoat and print blocking, and print resolution.

These settings are not set automatically at the client PC. You must enter these
settings manually on the client PC when you set up printing preferences. For
an overview, refer to “Configure PC Printing Preferences for Sharing” on
page 30.

Click OK to close the Printing Preferences window.

10. Turn on Simple File Sharing and Restart.

Make sure that you select (turn on) simple file sharing at this point in the
installation. Simple file sharing causes certain features, such as the Security tab, to
be hidden, allowing you to protect the permissions you set up.

Open the My Computer window.
Click Tools and select Folder Options.

Select the View tab.

D. Inthe Advanced settings list, select Use simple file sharing

(Recommended).
Click OK to save the change and close the Folder Options window.
Close the My Computer window.

You must restart your computer to apply simple file sharing. From the
Windows Start menu, select Restart.
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Install the Driver on the Client PC

B-6

For Windows XP only: Before the installation, you must install the “Windows XP
driver support” files (Service Pack 3). For more information, refer to “Install Support
Files” on page 20.

Make sure that the Card Printer Driver is installed and set up on the host PC.

Log on to the client PC with an account that has administrator privileges and
matches an account on the host PC.

The client PC must have a user account and password that matches an
account on the host PC.

Add the printer.

A.

B.

From the Windows Start menu, select Printers and Faxes.

Select Add printer.

| ndd Printar Wizard

Click Next on the Add e which e of e 13 16
Printer Wizard window.

Selek the option that dadcibas e Barbar pod vt 16 uia
Select A network ST AT
printer, or a printer ey Ty p—r
attached to another
computer, and then
v Tip sef up o resteork, pender thet is rot etteched o & pind perver,

click Next. d) uree Locdseinr:comen

On the Specify a Printer
page of the wizard,
select Connect to this
printer.

l & Btk :[ Mt 3 |[ Cancel

Enter the name of the host PC and the device printer name by doing one
of the following:

« Use the names you wrote down during the host PC installation using
the format:

\\host PC name\shared printer name

Windows XP Printer Sharing



« [If you don’t have the printer name, enter the host PC name using the
format:

\\host PC name\
When you type the last backslash without the printer name, a list of

host printers displays in a drop-down list. Select the shared printer
from the list.

G. Click Next. The Connect to Printer dialog box displays.

H. Click Yes to continue. The Default Printer page displays set to Yes and the
shared card printer icon displays on the Printers and Faxes window.

|.  Click Next to display the Completing the Add Printer Wizard page.
J. Click Finish to close the wizard.

4. If card production software is installed on this computer, or if you need other
support files, such as magnetic stripe fonts, install the Printer Plug-in or
support files from the Driver Installation CD. For instructions, refer to “Install
Support Files” on page 20.

5. Set up Windows printing for card design.

A. Get the Printing preferences settings you wrote down at the host PC for
the split-ribbon option, topcoat and print blocking, and print resolution.
These settings are not set automatically to match the host PC, so you must
enter them manually.

B. From the Printers and Faxes window, right-click the card printer icon and
select Printing preferences.

C. On the Printing Preferences window, enter the required printing
preferences. Refer to “Configure PC Printing Preferences for Sharing”
on page 30 and “Design Tasks in Windows Printing Preferences” on
page 59.

D. Click OK to close the Printing Preferences window.
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Appendix C: Windows Server
2003 Printer Sharing

This appendix provides information about how to
install and share the Card Printer Driver on a PC
running the Windows Server 2003, 32-bit operating
system.

Windows Server 2003, 32-bit Installation

Printer sharing involves setting up the host PC for sharing, then installing and
setting up the Card Printer Driver on each client system that prints to the printer.

Set Up the Host PC for Printer Sharing

1. Install the XPS Card Printer Driver on the host PC. Refer to “Install the
Driver” on page 8.

2. From the Windows Start menu, select Printers and Faxes. The Printers window
displays.

3. Write down the printer name and the host PC name.

You need the printer name and host PC name to install the Card Printer Driver on
the client PC. Record them and have them available when you install the client
PC. For more about printer names, refer to “Use device naming rules for
shared printers” on page 30.

A. In the Printers window, find the name of the newly installed card printer
and write it down.

B. Find the host PC name and write it down.

i. From the Windows Start menu, right-click My Computer and select
Properties.

ii. Click Computer Name. The host PC name displays in the Full Computer
Name field.

iii. Write down the name of the host PC.

iv. Click OK to close the System properties window.
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Enable printer sharing.

A.

C.

D.

In the Printers window, right-click the card printer icon and select Sharing.
The Printer Properties window displays the Sharing tab.

Click Share this printer to enable sharing. The printer name displays in the
Share name field. Make sure that a printer name displays.

The printer Share name is assigned by the Windows operating system. This
displays as the same printer name (or an abbreviated version of the printer
name) you wrote down earlier.

Click Apply to save the settings. The “hand” symbol (for “shared device”)
shows under the card printer icon in the Printers window.

Click OK to close the Printer Properties window.

Configure the host PC printing preferences.

A.

B.

Open the Printing Preferences window.

Enter your printing preferences. For instructions, refer to “Design Tasks in
Windows Printing Preferences” on page 59.

Write down the printing preferences settings for split-ribbon color
printing, topcoat and print blocking, and print resolution.

These settings are not set automatically at the client PC to match the host. You
must enter these settings manually on each client PC when you set up printing
preferences. For an overview, refer to “Configure PC Printing Preferences for
Sharing” on page 30.

Click OK to close the Printing Preferences window.
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Install the Card Printer Driver on the Client PC

The client PC may use any of the supported Windows operating systems. Refer to
“Printer Sharing Requirements” on page 26 for a list of supported host/client
operating system combinations. Except as noted, these steps apply to all client
Windows systems. The instructions may vary slightly based on the operating

system of the client PC.

1. Make sure that the Card Printer Driver is installed and set up on the host PC.

2. Log on to the client PC with a user account that has administrator privileges
and matches an account and password on the host PC.

o Before you log on, look for a user account that matches an account on the host PC. If
one is not listed, set up the user account and password on the client PC.

3. Add the printer.

A. Display the appropriate Printers window, as follows:

Operating System

Action:

Windows XP

Select Printers and Faxes. The Printer and
Faxes window displays.

Windows 7,
Windows 8

Select Devices and Printers. The Devices
and Printers window displays.

B. Select Add a printer from the Printers window. The Add Printer wizard

displays.

C. If needed, click Next on the Add Printer wizard.

The Local or network printer page displays.

D. Add a network printer.:

Operating System

Action:

Windows XP

Select A network printer, or a printer
attached to another computer.

Windows 7

Select Add a network, wireless or
Bluetooth printer. The Searching for
available printers page displays.
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E. Connect to the shared printer:

Operating System Action:
windows XP Click Next. The Specify a Printer page
displays.
Select Connect to this printer.
windows 7 If the card printer does not display, click
windows 8 The printer that | want isn’t listed. The

Find a printer page displays with the
option Select a shared printer by name
automatically selected.

F. Enter the name of the host PC and the shared printer name by doing one
of the following:

= Use the names you wrote down during the host PC installation using
the format:

\\host PC name\shared printer name

= [f you don’t have the printer name, enter the host PC name using the
format:

\\host PC name\

When you type the last backslash without the printer name, a list of
host printers displays in a drop-down list.

Select the shared printer from the drop-down list.

G. Click Next. A message states that you are about to connect to the printer.
Another message may display that states “To use the shared printer...you
need to install the printer driver.”
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H. Install the Card Printer Driver:

Operating System Action:

Windows XP Click Yes to continue.

The Default Printer page displays set to Yes
and the shared card printer icon displays
in the Printers and Faxes window.

Click Next.

Windows 7 Click Install Driver. When a message
states that you successfully added the
printer, click Next.

A message notifies you that you successfully added the printer.
|.  Close any open windows.
J. Click Finish to end the wizard.

4. |If card production software is installed on this computer, or if you need other
support files, such as magnetic stripe fonts, install the Printer Plug-in or
support files from the driver CD. For instructions, refer to “Install Support
Files” on page 20.

5. Set up Windows printing for card design.

A. Get the printing preferences settings you wrote down at the host PC for
the split-ribbon option, topcoat and print blocking, and print resolution.

These settings are not set automatically at the client PC to match the host,
so you must enter them manually.

B. From the Printers window, right-click the card printer icon.
C. Select Printing Preferences. The Printing Preferences window displays.

D. Enter the printing preferences. Refer to “Configure PC Printing
Preferences for Sharing” on page 30 and “Design Tasks in Windows
Printing Preferences” on page 59.

E. Click OK to close the Printing Preferences window.
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Appendix D: Windows Server
2008 and 2012 Printer Sharing

This appendix provides information about how to
install and share the Card Printer Driver on a PC
running either the Windows Server 2008 or
Windows Server 2012, 64-bit operating systems.

Windows Server 2008 or 2012, 64-bit Installation

Printer sharing involves setting up the host PC for sharing, then installing and
setting up the Card Printer Driver on each client system that prints to the printer.

Set Up the Host PC for Printer Sharing

1. Install the XPS Card Printer Driver on the host PC. Refer to “Install the
Driver” on page 8.

2. Configure the host PC for printer sharing.

A. From the Windows Control Panel, select Network and Internet >
Network and Sharing Center.

B. Select Change advanced sharing settings from the left column. The
Advanced sharing settings window or the Network profile options display. If
the Advanced sharing settings list displays, select the network profile you
want to work with.

The Advanced sharing settings display varies depending on a system’s setup.
In addition, based on its setup, the system may open one of the profiles and
display the options shown in step C.

C. Onthe network profile options page, select the following options:

Eield Select option

Network discovery Turn on network discovery

File and printer sharing Turn on file and printer sharing
Password protected Turn on password protected sharing
sharing

D. Click Save changes to close the Advanced sharing settings window.
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3.

Write down the printer name and host PC name.

Remember to record the printer device name. You need this printer name to install
the Card Printer Driver on the client PC.

A. Display the Devices and Printers window. Select the card printer icon and
click Print server properties in the menu bar. The Printer Properties
window displays.

B. Select the General tab on the Printer Properties window to display the
printer device name.

C. Write down the name of the printer.

D. From the Windows Start menu, display the System properties window for
your computer.

E. Write down the host PC name found in the Full Computer Name field.
F. Close the System properties window.

Enable printer sharing.

A. Select the Sharing tab on the Printer Properties window.

B. Click Change Sharing Options. The shaded fields become active.

C. Select Share this printer.

D. Make sure that a printer name displays in the Share name field.

The printer Share name is assigned by the Windows operating system. This
displays as the same printer name (or an abbreviated version of the printer
name) you wrote down earlier.

E. Select Render print jobs on client computers.

F. Click Apply to apply these settings.
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5. Configure security.
o Skip this Configure security section if you want to accept the following defaults:
= All users (the Everyone account) can print.

= Only the person who enabled sharing on the printer (the
CREATOR OWNER account) can view printer error messages at the
client PC.

Users at the client PC can view printer error messages from the Windows
Print Manager. These printer errors can be resolved at the printer LCD screen or
host PC.

For more information, refer to “Security permissions for shared printers” on page
28, and “View message boxes” on page 28.

A. Select the Security tab on the Printer Properties window.

B. Review the Group or user names list. Do the following to add users to the
list.

i. Click Add. The Users or Groups dialog box displays.

Select this object type:

|U5ers Object Types... |
From this location:

[HP3G_6 Locations... |

Enter the object names to select {examples):

Clieck Mames

Advanced... | ] 8 Cancel

ii. Selectthe name you want to add, and click Add. Repeat for each name
you want to add.

iii. If the names or group do not display in the list, add the names or a
group as follows. Repeat for each name you want to add.

« Click Advanced. The Select Users or Groups dialog box displays.

= Select Object Types. The Object Types window displays.
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e Select Users.

e Click OK. The Select Users or Groups search window displays.
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« Click Find Now. A list of user names displays in the search results
section.

* Select each name you want to add.

« Click OK. The Select Users or Groups window displays the names
you selected.
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Select this object type:
|U5ers Object Types... |
From this location:
[HP3G_6 Loeations... |
Enter the object names to select {examples):

HP3G &\Guest Check Names |

Advanced. .. | QK I Cancel I
P

iv. When you finish adding names, click OK to close the Users and Groups
dialog box.

C. Inthe Names list, select the name or group to set up.

o Do not select the Manage documents or the Deny check boxes for any user
or group. Select Allow for Manage Printer if you want a user or group to
view message boxes.

i. Select Allow for permissions you want to apply to the user or group.

ii. Clearthe Allow check box for permissions you want to deny the user
or group.

iii. Click Apply to save your changes. Make sure that you save changes for
each name.

D. Click OK to close the Properties window.

6. Configure the host PC printing preferences. Write down the printing
preferences settings for the split-ribbon option, topcoat and print blocking,
and print resolution.

These settings are not set automatically at the client PC to match the host.
You must enter these settings manually on the client PC. Refer to “Configure
PC Printing Preferences for Sharing” on page 30 and “Design Tasks in
Windows Printing Preferences” on page 59.
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Install the Card Printer Driver on the Client PC

The client PC may use any of the supported Windows operating systems. See
“Printer Sharing Requirements” on page 26 for a list of supported host/client
operating system combinations. Differences between operating systems are
noted, as needed.

1. Make sure that the Card Printer Driver is installed and set up on the host PC.

o Before you log on to the client PC, look for a user account that matches an
account on the host PC. If one is not listed, set up the user account and
password on the client PC.

2. Login to the client PC with a user account that has administrator privileges
and matches an account and password on the host PC.

3. Add the printer to the client PC.
A. Display the Printers window for your system.
B. Select Add a printer. The Add Printer window displays.

Windows 7 and Windows 8: Select Add a network, wireless, or Bluetooth
printer.

A list of available printers displays.
C. If the printer does not display in the list:

i. Select The printer that | want isn’t listed. The Find a printer page
displays.

ii. Enter the name of the host PC and the shared printer name by doing
one of the following:

= Use the names you wrote down during the host PC installation
using the format:

\\host PC name\shared printer name

e If you don’t have the printer name, enter the host PC name. Use
the format:

\\host PC name\

When you type the last backslash without the printer name, a list
of host printers displays in a drop-down list.

D. Select the host printer and then click Next. The message “Do you trust this
printer?” may display.

D-6 Windows Server 2008 and 2012 Printer Sharing



E. Click Install driver.
The Add Printer page states that you successfully added the printer.
F. Click Next.

G. Click Finish. The shared card printer icon displays in the Devices and
Printers window of the client PC.

4. If card production software is installed on this computer, or if you need other
support files, such as magnetic stripe fonts, install the XPS Card Printer Plug-in
or support files from the Driver Installation CD. For instructions, refer to
“Install Support Files” on page 20.

5. Configure the client PC printing preferences.

A. Get the printing preferences settings you wrote down at the host PC for
the split-ribbon option, topcoat and print blocking, and print resolution.

These settings are not set automatically at the client PC to match the host,
so you must enter them manually.

B. From the Devices and Printers window, right-click the card printer icon and
select Printing preferences. The Printing Preferences window displays.

C. Enter the required printing preferences. Refer to “Configure PC Printing
Preferences for Sharing” on page 30 and “Design Tasks in Windows
Printing Preferences” on page 59.

D. Close the Printing Preferences window.
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